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Chapter 1: Introduction to the Basics User

This section contains the following topics:

About this Guide (see page 11)
Quick Tour of CA Clarity PPM (see page 12)

About this Guide

This guide introduces basic information and techniques for working in CA Clarity PPM.
This guide assumes that the reader is a non-administrative CA Clarity PPM user who has
the appropriate access rights needed to perform basic functions.

The procedures described are for CA Clarity PPM with no customization. If you have
personalized changes or if an administrator has modified the user interface, the
procedures can vary from what you see.

Chapter 1: Introduction to the Basics User 11



Quick Tour of CA Clarity PPM

Quick Tour of CA Clarity PPM

The following illustration shows the default home page and its main components. The
components and features available from this page are described in the following
sections.

bain menu bar IJzer toolbar

General
Partlets lcons

Overview: General "j Pi E -.'é'.

Mications Action kems Favorite Links \

Wiy, Action fems Assigned to e j rou hawe no items to
display.

Action kems
Change Requests There are no action items to dizplay.

Dizcuszions

Diocuments

Ezcalations Hew

Favorite Photo

Finance
ou hawve no phota

My Projects selected.

Incidents
lzzues
Processes

Projects There are no tems to display

Reports and Jobs Site Links
Requisitionz
Rizk=

Timesheets

e Al ‘/

Hew Hew from Template There are no Site Links

o o o o o o o oo o oo oo O
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Quick Tour of CA Clarity PPM

Main Menu

Move the cursor over the following features on the main menu to see a tooltip that
identifies the feature.

The following list explains the numbered features in the preceding figure:
1-Back

Returns you to the previous page. The page you return to is based on the previous
entry in the Recent Pages list.

2-Recent Pages (History)

Provides a drop-down list of the pages most recently viewed. You can select from
the list to return to a page. Entries are not made for navigation between subpages
that belong to a specific instance. For example, if you are navigating between the
subpages of a specific project, the subpages are not listed in the Recent Pages list.

3-Home, Administration, and Favorites Menus

Provide the navigation to all the CA Clarity PPM pages. The menus and options that
you can view depend on your access rights.

4—-Refresh
Renews the data on a page.
5-Home
Returns you to the home page.
6—Current Timesheet
Takes you to your current open timesheet.
7-Search

Opens a search window for CA Clarity PPM.

Chapter 1: Introduction to the Basics User 13



Quick Tour of CA Clarity PPM

User Toolbar

Page Icons

The User toolbar always displays at the top of the page.

2 tary Bell Logout | Help | About

Use the links on the toolbar to access the following:
Logout
Logs you out, ends the session, and presents the Login window.
Help
Provides online help information for the individual CA Clarity PPM pages.
About

Provides information about the CA Clarity PPM version, the logged-in user, and
third-party software.

Learn (Optional)

Presents the CA PA training modules for your organization. The link displays only if
CA PA is set up for your organization.

The icons that are shown in the following figure provide quick access to functions
needed on a CA Clarity PPM page. Not all icons appear on all pages. The icons appear
only if the functions they represent are available for the page.

2 B RS

Export to Excel

Exports information from a page to an Excel format. The icon appears only if the
page has portlets.

Export to PowerPoint

Exports content from a page to a PowerPoint format. The icon appears only if the
page has portlets.

Personalize

Allows you to customize a page by adding or removing a portlet, adding or
removing a filter, or changing the layout of portlets.

Manage My Tabs

Allows you to create new tabs, add content to tabs, and change the layout of
portlets on tabs.
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Quick Tour of CA Clarity PPM

Overview Page Portlets

A portlet provides a snapshot of specific CA Clarity PPM data. A portlet can be a list, a
chart, or a snippet of HTML. You can select the data that displays in a portlet.
The Overview page contains the following portlets:
Action Items

Provides a list of action items that are assigned to you.
Favorite Links

Provides a list of internal CA Clarity PPM links you save.
Favorite Photo

Provides a list of your photos.
My Projects

Provides a list of projects you select for easy access from this portlet.
Notifications

Provides a list of notifications that are sent to you.
Site Links

Provides a list of external internet sites you save.

Tab Menus

Some tabbed pages have menus on the tabs. When you select a tab on a page, if a menu
is available for the tab, an arrow displays on the tab.

Click the displayed tab once to open the menu and view the menu options.

The following illustration shows the open Team tab menu.

Properties

Project: Librar >™" - Staff
Dretail
Role Capacity %
. Patticipants
Filter: System Farticipant Groups
There are no items|  Reduistions
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Chapter 2: Getting Started

Home Menu

This section contains the following topics:

Home Menu (see page 17)

Set a Home Page (see page 18)
View Your Information (see page 18)

The Home menu is the main menu for CA Clarity PPM users. The following illustration

shows the Home menu expanded. To open and expand the menu, move the pointer
over the menu name.

g

A Fre Next =

Personal Organization IT Service Management Portfolic Management
Owervieyy Departments Services Paortfolios

Organizer Knowledge Store Programs

Dashboards Projects

Portlets Applications

Timesheets Aszets

Feportz and Jobs Products

Accourt Settings Cther Wiork

Set 3= Home  Reset Home ﬁ?efresh

The menu options that appear on the Home menu depend on the rights that are
granted to you. Menu selections can vary for each user.

The menu includes the following features:

Previous and Next

Scrolls to the right or the left when clicked. If the Next button is active (bolded),
more menus appear to the right on the menu. If the Previous button is active, more
menus appear to the left.
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Set a Home Page

Set as Home
Sets the page currently open as your home page.
Reset Home

Resets the home page to the default home page, the Overview page.

Refresh

Updates the menu to include recent changes.

Set a Home Page

The default home page is the Overview page. You can set any page as the home page.

Follow these steps:
1. Navigate to the page you want as the new home page.
2. Open Home and click Set as Home at the bottom of the menu.

To reset the home page to the default Overview page, open Home and click Reset Home
at the bottom of the menu.

View Your Information

To view your information, open one of the following pages:
Overview
To view this page, open the Home menu and from Personal, click General.

Overview is the default home page. This page contains portlets that list your action
items and notifications. This page also contains portlets to which you can add:

m  Personal links for easy access to projects

Pages inside CA Clarity PPM
m External internet addresses

m  Favorite photos
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Organizer

To view this page, open the Home menu and from Personal, click Organizer. This
page contains detailed information about your action items, notifications,
processes, and tasks.

m  Action Items (see page 19)
m  Notifications (see page 20)
m  Processes (see page 21)

m  Tasks (see page 23)

Action Items

Action Items are nontasks that you assign to yourself, or others assign to you. You can
use action items to track the progress of projects and to help ensure that a project is
complete and on time.

You can create both personal and project-related action items. You create personal
action items from the Organizer page and project-related action items from within a
project. The Action Items tab on the Organizer page lists all of the personal and
project-specific action items that you create. The Action Items tab also lists action items
that others create and assign to you.

Create an Action ltem

You are the owner of action items you create. As the owner, you can modify or delete
an action item. You can modify the properties of a personal action item you create from
the Action Item Properties page. For an action item assigned to you by another user,
you can update only the status.

Note: For more information, see the Project Management User Guide.

Follow these steps:
1. Open Home, and from Personal, click Organizer.

2. Click New.

3. Complete the requested information in the General section. The following fields
require explanation:

Due Date

Defines the date the action item is due for completion. If desired, select the
hour and minute the action item is due.

Recurring

Indicates if the action item occurs at regular intervals. If the action item is to
occur only once, clear this check box.
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Notifications

Frequency
Specifies how often the action item to reoccur.

Example: Enter 1 to create a status report each week.

Until
Indicate the last date on which you want the action item to reoccur.

Complete the requested information in the Notify section. The following fields
require explanation:

Notify Assignees
Indicates if a notification has to be sent.
Send Reminder

Indicates if a reminder email notification has to be sent to the assigned
resources when the action item is due.

Time Before Reminder

Defines the amount of time before an item is due that the reminder occurs. For
example, enter 15, and select Minutes in the Units field.

Units

Specifies the unit of time for the reminder if the Send Reminder check box is
selected.

Enter the name of the resource to assign the action item in the Assignees section
and save your changes.

Assign To
Defines the name of the resource that is assigned to the action item.

Default: The resource that is currently logged in.

A notification can be an alert, an email, or an SMS message that notifies you of new
activities or changes in CA Clarity PPM. The alerts that you can see are for your assigned
action items or overdue timesheets.

An alert notification appears in the following locations:

Overview page on the Notifications portlet

Organizer page on the Notifications tab
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Open an Action Item from Notifications

Processes

The following procedure explains how to open an action item from the notification list.
You can delete notifications that you no longer need.

Follow these steps:

1.
2.

Open Home, and from Personal, click Organizer.

Click Notifications.

Click the link in the Message column or the Properties icon that displays next to the
alert notification.

A process is a series of actions or steps in the product resulting in an end. All processes
have the following characteristics:

A start step and finish step.
Post-conditions and preconditions to connect the steps.

Each step performs a single action that is intended to move the process toward its
completion.

Note: Processes are not explicitly marked as complete. The completeness of a process
instance depends on the status of the steps it contains. When the Finish step is
completed, the process instance ends.

You can view the following processes from the Organizer:

Initiated

Includes process instances that you started or to which you have the view access.
You can view the status or click a process link to view the step details.

Available

Includes processes available for you to initiate and to edit their definitions. You can
start a process or click a process link to edit its definition. You can also create new
processes.

Note: To view a list of all available global processes, process administrator access is
required.

Follow these steps:

1.
2.
3.

Open Home, and from Personal, click Organizer.
Click Processes.

Open the Processes menu, and click Available or Initiated.
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Start a Process

Modify a Process

Each time a process is started, by either a manual action or an automated trigger, a
process instance is created.

Follow these steps:

1.

2
3.
4

Open Home, and from Personal, click Organizer.

Click Processes.

Open the Processes menu and click Available.

Select the check box next to the process you want to start, and click Start.

You can only modify processes that have Mode set to Draft or On Hold. If the mode is
set to Active, you cannot modify a process. The appropriate access rights are required to
modify a process.

Follow these steps:

1.

2
3.
4

Open Home, and from Personal, click Organizer.

Click Processes.

Open the Processes menu, and click Available.

Click the name of the process to modify.

Complete the following steps:

Modify the generic attributes for this process.

Update the process steps as desired by adding, renaming, deleting, adding
conditions to, or altering actions.

Update groups by adding, removing, reorganizing, or renaming them.

Update escalation properties by changing escalation type, level, grace period,
or additional notifications.

Click the Validation link to validate the process modifications. If you identify
any errors, correct them and revalidate the process. If there are no errors, click
Exit.
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Cancel a Process Instance

Tasks

You can cancel only active and incomplete processes. When you cancel a process
instance, the process instance stops at the step in progress. Canceled process instances
are not deleted and remain for reference purposes. You cannot reinstate a canceled
process.
Follow these steps:
1. Open Home, and from Personal, click Organizer.

Click Processes.

2

3. Open the Processes menu and click Initiated.

4. Select the process instance, and click Cancel Process.
5

Click Yes to confirm.

A personal task is a work item for which you can log work in your timesheet and can
track the progress. You can view personal tasks that you create and those others assign
to you. A task entry appears in the task list for each assigned task. You can use this page
to perform the following actions:

m  Open the task

m  Edit the displayed task properties

m  Mark a task as complete or not complete

You can update a personal or assigned task to ensure that information about tasks is

up-to-date.

Follow these steps:

1. Open Home, and from Personal, click Organizer.

2. Click Tasks.

3. Open the task you want to update.
The following task properties appear. You can edit the appropriate fields as needed:
Task

Defines the name of the task. The value for the field is derived from the Name
field on the Task Properties page. On list pages or in portlets, displays the name
of the task.

Limits: 64 characters
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4.

Investment

Displays the name for the investment. The value for this field is based on the
Project Name field on the Project Properties page.

Start

Defines the date to start the task assignment for a resource. The list pages or
portlets display the start date.

Default: Task start date

Note: Define the assignment to start on or after the task start date. If an
assignment has actuals, the field is read-only.

Finish
Defines the date to complete the task assignment for a resource. The list pages
or portlets display the completion date.
Default: Task completion date

Note: Define the assighnment to finish on or before the task completion date.

Actuals

Displays the total work units that a resource has worked and posted to the task
assignment.

Pending Actuals

Displays the number of hours that a resource enters on a submitted timesheet
that is waiting to be posted.

ETC

Displays the estimated hours to complete the task. Click in the cell to edit the
value.

Assignment Status

Displays the status of the task. The value for this field is derived from the Status
field on the Task Properties page.

Values:
m  Not Started. No time is posted against the task.

m  Started. Automatically changes the status to Started when time is posted
against the task.

m  Completed. Automatically changes the status to Completed when the task
ETC has zero hours and the task status is updated to Completed.

Save your changes.
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Favorites

Favorites is a personal menu that you can use to store the links you use every day. The
Favorites menu lets you store a link to any page as a favorite for easy access at any time.

You can add and manage the Favorites menu in the following ways:

m  Save a Page as a Favorite (see page 25)

m  Add a Favorites Page Link (see page 25)

m  Add a Favorites Action Link (Favorites) (see page 26)

m  Add a Favorites Menu Section (see page 26)

m  Reorder Menu Sections (Favorites) (see page 27)

m  Remove a Menu Section or Link (see page 27)

Save a Page as a Favorite

You can save any page as a favorite.

Follow these steps:
1. Open the page to save as a favorite.

2. Open the Favorites menu, and click Add Current.

Add a Favorites Page Link

This procedure explains how to add a page link to the Favorites menu.

Follow these steps:

1. Open Favorites, and click Configure.

2. Click Add.

3. Select Page Link and click Next.

4. Complete the requested information:
Link Name

Defines the label for the page link that appears in the menu.
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Description

Defines the purpose for the section or page link.
Page Name

Specifies the page that appears when the link is clicked.
Parent Menu Item

Specifies the menu section in which the link appears.

Save your changes.

Add a Favorites Action Link

This procedure explains how to add an action link to the Favorites menu.

Follow these steps:

1.
2.
3.

Open Favorites, and click Configure.
Click Add.

Select Action Link and click Next.
Complete the requested information:
Link Name

Defines the name of the link for the action. The link name is the label that
displays in the menu.

Description

Defines the purpose of the link.
Action Name

Specifies the action that occurs when the link is clicked in the menu.
Parent Menu Item

Specifies the section in which the link appears.

Save your changes.

Add a Favorites Menu Section

This procedure explains how to add a section to the Favorites menu.

Follow these steps:

1.

Open Favorites, and click Configure.
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2. Click Add.
3. Select Section and click Next.
4. Complete the requested information:
Section Name
Defines the name for the section.
Section ID
Defines the unique identifier for the section.
Description
Defines the purpose for the section or page link.

5. Save your changes.

Reorder Menu Sections

This procedure explains how to reorder sections and links in the Favorites menu.

Follow these steps:
1. Open Favorites, and click Configure.
2. Click Reorder.

3. Select a section in the Menu Items list box, and click the arrows to move the section
to a new position.

4. Save your changes.

Note: If you do not see your changes reflected in the menu, click the Refresh button.

Remove a Menu Section or Link

You can remove a menu section, page link, or action link. You can only remove sections
or links that you have created. You cannot remove the CA Clarity PPM default sections
or links.

Follow these steps:

1. Open Favorites, and click Configure.

2. Select the check box next to the section or link to delete, and click Remove.

3. Click Yes to confirm.
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Chapter 4: How to Manage Your Account
Settings

You can use the Account Settings pages to change elements of your resource profile,
assign your action items to a different user, and to download software. You can use the
Personal Information page to manage your account settings.

You can manage your account settings in the following ways:

m  Manage Your Personal Information (see page 29).

m  Update Your Password (see page 30).

m  Designate Proxies (see page 30).

m  View Your List of Proxies (see page 31).

m  Setup Notifications (see page 31).

m  Download Software (see page 32).

Manage Your Personal Information

You can use the Personal Information page in Account Settings to perform the following
tasks:

m  Update your contact and password information
m  Reset your home page
m  Set the current timesheet as your home page

For more information about managing resources, see the Resource Management User
Guide.

This procedure explains how to manage your personal information.

Follow these steps:
1. Open Home, and from Personal, click Account Settings.

2. Complete the requested information in the General Information section. The
following fields require explanation:

Time Zone

Defines the primary workplace time zone.
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Locale

Defines your work locale. The locale drives the number and date language
formatting in the product.

Default: English (United States)
Language

Defines the language to use the product. The language that is selected here
also applies to the Business Objects reports for the resource.

Note: Change in the language takes 15 minutes to reflect. You can wait, or can
log out and log back in to reflect the change.

Default: English

3. Saveyour changes.

Update Your Password

You can include an unlimited number of characters in your password.

Best Practice: Select a combination of letters and numbers in your password to help
ensure that your information remains secure.

Follow these steps:

1. Open Home, and from Personal, click Account Settings.

2. Complete the requested information in the Change Passwords section, and save
your changes.

Designate Proxies

You can temporarily designate another resource as your action items proxy using the
Proxy page in Account Settings. As a proxy, the assigned resource receives action items
such as your regularly scheduled or urgent actions items during the specified proxy
period.

During the period that an action item is due, the designated proxy sees the action item
in their Action Items portlet on their Overview page.

Important! Verify that the resource designated as your action items proxy has the
appropriate access rights for the actions they must process. For example, if you
designate a proxy to receive action items to approve timesheets, the proxy requires the
Timesheets - Approve All right.
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Follow these steps:
1. Open Home, and from Personal, click Account Settings.
2. Click Proxy.

3. Complete the requested information in the Setup section, and save your changes.

View Your List of Proxies

If other resources have designated you as their action items proxy, their names appear
in the Resources field on the Proxy page of Account Settings. Any action items that
become due during the proxy period display in your Action Items portlet on the
Overview page. One or more resources can designate you as a proxy.

Set Up Notifications

Notifications are automatically generated when certain actions are triggered. You can
view and manage the method in which you receive your notifications when their
associated events are triggered. For example, you can set up notification by email when
someone responds to an action item.

Use the Notifications page in Account Settings to specify, or change the types of
notifications you want to receive. You can also specify the method to receive
notifications. All the method check boxes for each functional area are selected by
default.

The following list describes examples of situations that trigger notifications for each
functional area:
Action Items

A notification is sent out when a new action item is assigned to you and when one is
due.

Change Request
A notification is sent when you are assigned to a change request.
Escalation

A notification is sent when a process fails or stalls and you are identified as the
person to notify for escalations.

Issues
A notification is sent when you are assigned to an issue.
Processes

A notification is sent when a resource identifies you as the person to contact for a
certain step in a process.
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Projects

A notification is sent when a resource adds you or when a resource removes you
from a project.

Reports and Jobs

A notification is sent when a report or job you initiated, scheduled, or assigned to is
completed or failed.

Risks
A notification is sent when you are assigned to a risk.

Timesheets
A notification is sent when you receive a notification for a timesheet submitted. If
you submitted a timesheet, you can receive a notification that it is overdue or it is
returned.

Follow these steps:

1. Open Home, and from Personal, click Account Settings.

2. Click Notifications.

3. Select the functional areas and methods to receive notifications.

4

Save your changes.

Download Software

The CA Clarity PPM administrator requires setting up the installation files on the CA
Clarity PPM server. To download software, you require:

m  Access rights to download the software.

m  Administrator rights to install the software.

Note: Even if you have the appropriate access rights, the software may not be available.
Make a note of the folder location to which you install the software.

You can download the following software from CA Clarity PPM:

Open Workbench

This application is desktop project management software. You can use Open
Workbench as a stand-alone software application or with CA Clarity PPM.
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Microsoft Project Interface

Use CA Clarity PPM Microsoft Project Interface to connect Microsoft Project with
CA Clarity PPM.

Java Runtime Environment

Use Java Runtime Environment to use XML Open Gateway (XOG) to pass data
between CA Clarity PPM and other programs.

Adobe SVG Viewer

Allows you to view graphical portlets and processes.

SAP BusinessObjects Xcelsius 2008

Use Xcelsius to create visualizations and to set up the data connections. Download
and install the Xcelsius locally on your computer.

Note: For this download link to display on the Software Downloads page, you
require access rights to install Xcelsius. In addition, the CA Clarity PPM
administrator requires copying the Xcelsius setup zip file to a CA Clarity PPM install
folder.

Contact your CA Clarity PPM administrator if you are unable to download Xcelsius.

CA Clarity Ul Themes as Xcelsius Color Schemes

Use to give the Xcelsius visualizations the same colors as your portlets and pages in
CA Clarity PPM. The CA Clarity PPM Ul themes are available to use in Xcelsius
visualizations.

Follow the instructions on the Software Downloads page to make the Ul themes
available as Xcelsius color schemes.

Design Files for Stock Xcelsius Visualizations

Helps you get started with sample implementations. You can use the Xcelsius
visualizations design files (.XLF) as is, or you can use them as a starting point to
design your own Xcelsius visualizations.

For more information, see the CA Clarity-Xcelsius Implementation Guide.

The following procedure explains how to download the client software from the product
to your computer.
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Follow these steps:

1. Open Home, and from Personal, click Account Settings.
2. Click Software Downloads.

3. Click the Download link corresponding to the software.

Depending on the software you select, a series of file download, "Save As", and
install windows open.

4. Follow the download instructions.
Note: See your CA Clarity PPM administrator for any assistance if you are unable to

download the required client software. In addition, contact your administrator if you
have questions about the download process.
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Chapter 5: How to Personalize CA Clarity
PPM

This section contains the following topics:

Introduction to Personalizing CA Clarity PPM (see page 35)
How to Personalize Pages (see page 36)

Present a Page as a Pop-up (see page 40)

How to Work with Lists (see page 41)

Introduction to Personalizing CA Clarity PPM

You can personalize pages, lists, charts, filters, and personal dashboards. The changes
that you make are visible only to you.

If you have the privileges to personalize, the related menus or icons appear on a page or
a portlet toolbar. If the owner changes and publishes the original item, you lose your
personal changes.

The content in this guide is based on the out-of-the-box version of CA Clarity PPM. If you
or your CA Clarity PPM administrator create any user-defined values and fields, or you
configure a page or portlet, the procedures for that page or feature in the guide can be
different.

To personalize a page, you can:

m  Add a portlet

m  Add a tab and tab content to tabbed pages
m  Edit tab details

m  Reorder the tabs

m  Delete atab

To personalize a dashboard, you can:
m  Add or remove portlets
m  Add or remove page filters

m  Change the layout of dashboard portlets
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You can configure lists, charts, and filter portlets that appear on pages, tabs, or
dashboards in CA Clarity PPM. To configure a list, you can:

Set the layout of columns

Set the options that determine how the list appears

Edit the fields

Add a Gantt chart, an image, a progress bar, or a time-scaled value

Add an aggregation row

To configure a chart, you can:

Change the chart type
Change the source data

Change the options that determine how the chart displays

To configure a filter portlet, you can:

Add a field
Add a lookup or a multivalued lookup

Decide the field layout

How to Personalize Pages

You can personalize your pages so that they display the information you need. By
personalizing a page, you view only the content that is relevant to your task and you can
display the content on the page in a way that best suits you.

Each CA Clarity PPM page is composed of portlets and the page content can be
organized into tabs.

To personalize a page, you can:

Add a portlet

Add a tab and tab content to tabbed pages
Edit the tab details

Reorder the tabs

Delete a tab

Note: The changes that you make are visible only to you.
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The following diagram describes how an application user personalizes pages:

How to Personalize Pages

Review Prerequisites

Application
Lser

Manage Page
Content

Add a Filter
to a Page

Manage Page
Layouts

Manage Page
Tabs

Personalized
Page

Follow these steps:

1. Review the Prerequisites (see page 37)

2. Manage Page Content (see page 38)

3. Add a Filter to a Page (see page 38)

4. Manage Page Layouts (see page 39)

5. Manage Page Tabs (see page 39)

Review the Prerequisites

To complete all tasks in the scenario, consider the following items:

®m  You must have sufficient access rights. For more information, see the Access Rights
Reference Guide.

Note: If you have the privileges to personalize, the related menus or icons appear
on a page or a portlet toolbar.

m  The page must be editable. Your CA Clarity PPM administrator must enable the
Allow users to add tabs and Personalize.
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Add and Manage Page Content

You can manage the page content by adding or removing portlets, or restoring default
portlets.

Follow these steps:

1. Onthe page, click the Personalize icon that is at the right top corner.

The Content page with a list of portlets that are already displayed on the page
appears.

2. Click Add and in the Select Content dialog, select the portlets that you want to add
to the page.

3. Complete one of the following steps:
m  Click Add or Add and Select More.
m  Click Return to save the changes and return to the page. Click Continue to make

further configuration settings.

To remove portlets from the page or restore the default content, use the Remove or
Restore Defaults buttons.

Add a Page Filter

You can add a filter portlet to a page to filter the page content.

Follow these steps:
1. Onthe page, click the Personalize icon at the right top corner.
2. Goto the Page Filters tab.
3. Click Add and select a filter from the list.
4. Click Add.
5. (Optional) Set the Persist and Default options.
Persist

Select the check box, if you are adding the filter portlet to pages and you want
the values in the filter to persist when you move from one page to another. The
filter values persist only across pages that use the same filter portlet.

Default

Select the Default option for the desired page filter default. The first filter that
is published to the page is the page filter default unless a selection indicates
otherwise.

6. Save your changes.
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Manage Page Layouts

Change the layout of the page by reordering the page content.

Follow these steps:

1.
2.
3.

Manage Page Tabs

On the page, click the Personalize icon that is at the right top corner.
Go to the Layout tab.
Select the layout template for the portlets in the Layout field.

Each option provides the number of columns and the percentage of the page that is
given to each column. In the Row Layout option, the number of portlets you place
in a row determines the percentage of space that is given to a portlet.

Use the arrow keys to move the portlets in the order you want for the page.

Save your changes.

You can create your personalized workspace by managing the tabs that appear on a
page and the portlets that appear on each tab.

You can use the Manage Tabs page to complete the following tasks:

Add new tabs and select the portlets for these tabs (see page 39).

Edit, reorder, or delete tabs (see page 40).

Add a New Tab and Tab Content

Add a tab to a page, and then add the portlets you want displayed on the page. The new
tabs that you add appear next as the last tab on the page.

Follow these steps:

1.
2.

3.

On the page, click the Manage My Tabs icon.
Click New.
Complete the Tab Name and Description fields and click Save and Continue.

Add and manage the page content (see page 38) that you want on the new tab, and
click Continue.

Add a page filter (see page 38) and click Continue.

Configure the layout (see page 39) and click Save and Return.
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Present a Page as a Pop-up

Edit Tabs
Edit the properties and content of existing tabs.

Note: You cannot edit the properties of all tabs. An editable tab shows a link when you
hover the mouse cursor over the list. You can edit the properties of custom tabs you
create.
Follow these steps:
1. Onthe page, click the Manage Project Tabs icon.
2. Onthe Manage Tabs page, click the name of the tab that you want to edit.
3. You can edit:
m  Page properties
m Page content (see page 38)
m Filters (see page 38)

m  Page Layout (see page 39)

4. Save the changes.

On the Manage Tabs page, you can also delete selected tabs or reorder them. Use the
respective buttons.

Note: You can remove the tabs that you create on a page. You cannot remove the CA
Clarity PPM default tabs, or the tabs that are installed with the PMO Accelerator add-in.

Present a Page as a Pop-up

Some lists display a Configuration icon in the Options toolbar. For these lists, you can set
items that are selected from the list to display in a separate pop-up that floats above the
workspace. A pop-up is one way to provide a visual reminder of where you are in the
application. The popup has the same functionality as a page presented in the
workspace.

Note: When you set an item on a list page to appear in a pop-up, all list items are set to
appear in a pop-up.

Follow these steps:

1. Open the list page you want to configure.

For example, open Home, and from Portfolio Management, click Projects. Open the
Projects list page.

2. Click the Options icon to open the menu, and click Configure.

3. Open the List Column Section menu, and click Fields.
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4. Locate the Name attribute in the Attribute column, and click the Properties icon.

5. Select the Open as Pop-up check box, and click Save and Return.

6. Click Return.

How to Work with Lists

You can use CA Clarity PPM to work with lists that relate to your projects. Lists can be
very long, so you can filter the list to view only what you want, sort the list to see the

items in the order you want, edit the lists to update and correct information, and export
lists to view and work with them in Excel.

The following diagram describes how a user can work with lists and filters:

How to Work with Lists

Resource or List Options Toolbar
Project
Manager *

Filter Lists Sort Lists Edit Lists

v

(Optional) Export Lists

Completed
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Follow these steps:

List Options Toolbar (see page 42).

o N e

List Options Toolbar

The Options toolbar displays on the top of lists. The toolbar options help you manage

Filter Lists (see page 43).
Sort Lists (see page 46).
Edit Lists (see page 47).
Export Lists (see page 47).

the information included in lists.

Filter

Lets you filter the list with criteria you select. Double-click the toolbar or click the
icons (+ or -) that appear next to the filter name to expand or collapse the filter. The
filter in use is listed in the filter field. To see a list of saved filters, click the down

arrow. For more information about filters, see Filter Lists (see page 43).

Options Menu

Lets you access options that apply to the portlet being viewed. The options that
appear can vary depending on the portlet. The following list shows some of the

options that appear on the Options menu.

Configure

You can configure the list in the following ways:

Modify the list and filter fields.

Modify the list and filter layout.

Aggregate the information in columns.

Set the options for how the list displays.

Define the display settings for a Gantt chart.

Define the time period settings for a time-scaled value.

Note: For more information, refer to How to Configure a List.
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Filter the Lists

Multisort

Allows you to sort the information in a list using multiple columns. For more
information about sorting, see Sort Lists (see page 46).

Export to Excel (Data Only)
Exports the list to Microsoft Excel. No charts are included in this export. For

more information about exporting, see Export Lists (see page 47).

Note: Some lists display a Configuration icon in the Options toolbar. For these lists, you
can set items that are selected from the list to display in a separate pop-up that floats
above the workspace. The pop-up has the same functionality as a page presented in the
workspace.

Lists with many items can span multiple pages. Use the filter fields to filter the list to
only those items you want to view.

Use the Expand/Collapse Filter icon on the Options toolbar to hide or display the filter.
When a list is filtered, you can return to the default results list and can view all the items
in the list page. Click Show All or select System Default from the Filter drop-down.

You can name a filter and can save the criteria for later use. Access saved filters from
the Filter drop-down.

Note: The filter fields are not case-sensitive.

Follow these steps:
1. Open the list page.
2. Click the Expand Filter icon if the filter is not open.

Enter the filtering criteria, and click Save Filter.

4. Enter a name for the filter.
5. Select Default to make this filter the default filter for this list page.
6. Save your changes.

Note: When you apply a filter to a hierarchical list, the expanded items collapse. The
resulting filtered items include its parent and up the hierarchy to the top-level item, and
all rows display collapsed.
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Build a Power Filter

A power filter is a custom filter that searches a list page by criteria you define. Use a
power filter alone or with other filter fields on the list page. Only one power filter can be
created for a list page.

You design and build a power filter using an expression. The expression is divided into
two parts, left and right, and separated by an operator, such as, =. For example, the
expression to search for all active projects on the projects list page appears in the
Expression text box as follows:
project.is active ==
Follow these steps:
1. With a list page open, expand the filter.
2. Click the Build Power Filter link in the filter section.
3. Complete the following fields to build the left part of the expression:

Note: The available fields are dependent on the page displayed.

Object

Specifies the type of object to filter. The page refreshes.
Field

Specifies the field to display in the Filter section. The page refreshes.

4. Select one of the following operators:

Note: The operators that are available are dependent on the object and field values
that are used for the left part of the expression.

=
m =
= >
m >=
m <
m <=
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Complete the following fields to build the right part of the expression:
Note: The fields that are available are dependent on the page displayed.
Constant

Specifies the constant for the field.

Values: Yes or No

Example: Select the Active field of the project object and use the equals
operator, then select Yes as the constant. This combination finds all active
projects.

Object
Specifies the type of object to filter. The page refreshes.
Field
Specifies the field to display in the Filter section. The page refreshes.
Click Add.
The expression appears in the Expression field.

Select a value from the following field to create an equation with multiple clauses.
For example, you can create a power filter with multiple clauses to display all active
projects that are also assigned to a specific department. If you select a value from
this field, create the additional clause for the expression and click Add. This action
appends the clause to the value in the Expression field.

And/Or
Specifies the equation type for the second half of the expression.
And
Defines an equation with multiple clauses.
Or
Defines an either/or equation.
Complete one of the following steps:

m  Click Evaluate to evaluate the syntax of the expression. If the syntax is not valid,
INVALID appears above the Expression text box.

m  Click Add Parenthesis to surround the expression with parentheses.

m Click Negate Expression to negate the expression by surrounding the
expression with parentheses and preceding it with an exclamation point.

m Click Clear to clear the Expression text box.
Save your changes.

The power filter is saved. The name appears in the Power Filter field of the page
filter.
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Sort the Lists

You can sort lists by row or column to view the items in the order you want. Once the
list is sorted, you can reset the sort to the default sort order. You can sort parent items
in lists. When the list is sorted, the child items inherit the sorting criteria of the parent.

To sort a column, click the column header. When the list is sorted, an arrow appears in
the column header. To reverse the sort order, click the column header again. Do the
same to sort by any other column headers.

Use the Multisort option to change the sort order of columns or sort by multiple
columns to change your page layout.

Follow these steps:

1.
2.

Open a list page.
Click the Options icon to open the menu and select Multisort.
Complete the following fields, and save:
First Field
Specifies the column that leads the sort order.
Type: Text
Displays information in alphabetical order.
Type: Numbers
Displays information in numerical order.
Second Field
Specifies the column that defines the second order of the sort.
Third Field
Specifies the column that defines the third order of the sort.
Fourth Field
Specifies the column that defines the fourth order of the sort.

Indicate the direction of the sort for each selection you make in a Column field:
ascending or descending.
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Edit the Lists

Export the Lists

When you click in a field to update, the entire list is placed into edit mode. Use the edit
feature to update and correct fields in a list. You can click links and icons in other fields
while the list is in the edit mode. A flag appears in the field to indicate an unsaved
update. Press the Esc key to return to the display mode and discard the unsaved
changes.

Note: If the field can be edited, the field changes to edit mode. If no action occurs, the
field cannot be edited.

In addition to editing lists, you can insert an item.

Note: If the list includes a time-scaled value column and you want to edit the

time-scaled information, save your changes first.

Follow these steps:

1. Open a list page.

2. Select the check box or click anywhere on the item row to insert a new row below
it.

3. Click New.

4. Edit the fields and save your changes.
The new row is inserted with the updated fields.

Note: Fields that are displayed are required.

You can export the information from any list portlet that displays the Export to Excel
(Data Only) icon in the Options toolbar. Exporting to Excel is especially helpful when the
list extends over multiple pages. To use statistical operations such as SUM and
AVERAGE, export and view the list in the Excel format.

Note: If the Export to Excel icon is not displayed, the list is restricted.

The following rules apply when you export information in a list:

®m  You can run only one active export at a time.

m  If you apply filter criteria, only the filtered results are exported.
m  Only first-level items are exported.

m  Only the fields that are displayed in the list are exported.

m  Only the items that are listed on the page are exported. If you have more than one
page, export these pages independently.
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m  Foritems that contain charts (including Gantt charts), you can export a maximum of
300 items.

®m  You can export an unlimited number of items without charts. Use the Export to
Excel (Data Only) option, and leave the Maximum rows for the Export to Excel field
empty.

m  The exported information appears in Excel or PowerPoint the way that information
appears in CA Clarity PPM.

®m  You can export some CA Clarity PPM pages that contain portlets, like the Overview
page. If you can export a page of portlets, the export option is available.

Important! Expect certain changes in how information is displayed in Excel when you
export CA Clarity PPM information to Microsoft Excel.

Before you export information, verify that you are exporting the returned results and
have not applied any pagination.
Follow these steps:

1. Open the list page that contains the information you want to export, and click the
Export to Excel icon.

2. Open the list as an Excel spreadsheet, or save it to your local desktop.
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You can personalize a list portlet in the following ways:

Set the layout of columns (see page 49)

Set list options that determine how the list displays (see page 50)

Add a Gantt chart (see page 51)

Configure the Gantt Chart display settings (see page 52)

Modify time period settings for a Gantt Chart (see page 53)

View and edit list portlet fields (see page 53)

Add an image (see page 54)
Add a progress bar (see page 54)

Add a time-scaled value (see page 55)

Add an aggregation row (see page 57)

Display an aggregation field (see page 58)

Set List Column Layout

This procedure explains how to set the list column layout.

Follow these steps:

1.
2.
3.

Click the Options icon that appears on the portlet toolbar.
Open the Options menu, and click Configure.

Select the columns in the Available Columns list and click the arrow to add them to
the Selected Columns list in the Column Layout section.

You can use the Move Up and Move Down arrows to place the selected columns in
the desired order.

Complete the following actions in the Column Sorting section:

a. Select the appropriate field in the Column drop-down list to select the order in
which you want to sort the columns.

b. Click Ascending or Descending to sort data within each column.
Note: Column sorting is not available for hierarchical list pages.

Save your changes.
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Set List Options

This procedure explains how to set list options.

Follow these steps:

1.
2.
3.

Open the Options menu that appears on the portlet toolbar, and click Configure.
Open the List Column Section menu, and click Options.
Complete the requested information. The following fields require explanation:
Secondary Value Display

Indicates how the secondary values display in a grid cell.

Values:

m  Mouseover only. Specifies no secondary value display.

m  Mouseover and redline text. Specifies the display of a secondary,
comparison value when you place the cursor over a cell in a grid. For
example, if you have two columns named Cost and Baseline Cost, you can
display both values in a cell. To display both, select Baseline Cost as the
secondary value. The Cost value displays as usual. However, when you
move the cursor over a cell in the grid, the Baseline Cost also displays.

m  Show Null Secondary Values. Specifies that the secondary value displays
even when there is no number value to show.

Filter

Indicates how the results appear initially on a page.

Display Currency Code in Column

Specifies whether to display the currency code in the column for money
attributes.

Allow Configuration

Indicates that users can modify the appearance of a portlet.
Allow Label Configuration

Indicates that users can modify portlet labels.

Save your changes.
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Add a Gantt Chart to a List Portlet

A Gantt chart is a virtual field that shows the duration and progress over time. New
virtual fields are automatically displayed in the far right column of the list. You can move
the field to a different position in the List Column layout.

Follow these steps:

1.

v W

o

Open the Options menu that appears on the portlet toolbar, and click Configure.
Open the List Column Section menu, and click Fields.

Click New.

Select Gantt, and click Next.

Complete the requested information in the General section.

Complete the requested information in the Time Scale section. The following fields
require explanation:

Time Scale

Specifies the time values to show across the top of the Gantt chart.
Number of Time Periods

Indicates the number of time periods to be displayed.
Time Period Offset

Defines the number of time periods you want to shift the beginning of the
Gantt bar relative to the Start Date. Enter a Start Date value to use this option.

Show Group Row Header

Indicates whether to print the time scale value used. Select the check box to
show the value and select the value to be shown from the drop-down list.

Complete the requested information in the Primary Bar section. The following fields
require explanation:

Item Name Attribute

Specifies the field name for the primary bar of the Gantt chart.
Start Date Attribute

Specifies the date field value to use at the beginning of the Gantt bar.
Finish Date Attribute

Specifies the date field value to use at the end of the Gantt bar.
Milestone Attribute

Specifies the field value to use as a milestone. Select a field from the
drop-down list. If the field contains a non-zero value, the Gantt chart displays a
diamond.
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Progress Through Date Attribute

Specifies the date field value to use to indicate when work is complete. If you
select a value, the selected value overrides the Progress Percent Attribute.

Progress Percent Attribute

Defines the percentage that is used to move the green progress line relative to
the length of the taskbar to indicate the completed work. If you select a value
for this field, it overrides the Progress Through Date Attribute selection.

Label for Bar
Specifies the label text to display above each taskbar.
Additional Information Attribute

Specifies the field that is used in the text note when you hover over a taskbar.
For example, to display the assigned resources for a task, when the cursor is
over a taskbar, complete the following steps:

m  Select Assigned Resources from the Additional Information Attribute field.
m Select Additional Information in the Show Mouseover field.
Show Mouseover

Indicates the values that appear when a user moves a cursor over the bar.
Select the check boxes of the items listed that you want to appear.

Select the dates you want to show on the primary Gantt bar from the Available list
in the Show Dates on Primary Bar section. Click the arrow to move the dates to the
Selected list.

(Optional) Select the Show Secondary Bar check box and complete the fields in the
section to display a second bar below the primary bar for comparison purposes.

10. Save your changes.

Configure the Gantt Chart Display Settings

Gantt charts appear on various pages throughout CA Clarity PPM. The steps to change
the display settings are the same from any page with a Gantt chart.

By default, Gantt charts display only one bar, the primary bar. You can change the
information that is displayed in that bar (Total Effort, by default). You can also add a
secondary bar to display complimentary or contrasting data. You can also change the
time configurations that display in the chart.

Follow these steps:

From a page that contains a Gantt chart, open the Options menu and click
Configure.

Open the List Column Section menu, and click Fields.
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3. Click the Properties icon next to Column Label. For example, Schedule.
4. Configure the Gantt chart display settings.

5. Save your changes.

Modify Time Period Settings for a Gantt Chart

You can change the Gantt chart timescale to zoom in and out of the timeline. For
example, if you are viewing the monthly timeline, to zoom in to see daily timeline
information, select the Days timescale value from the Calendar drop-down at the top of
the Gantt chart.
Follow these steps:
1. From a page that contains the Gantt chart, open the Options menu and click Gantt.
2. Modify the following fields:
Start Date
Indicates the start date for the column spread.
Time Scale
Specifies the time period by which data displays (days, weeks, and so on).
Number of Time Periods
Defines the number of time periods that display.
Time Period Offset

Defines how to shift the beginning of the Gantt bar relative to the start date.
Enter a positive or negative number of time periods into the field.

3. Save your changes.

View and Edit List Portlet Fields
You can view and edit the fields that display in a list portlet.

Follow these steps:
1. From a page that contains the Gantt chart, open the Options menu and click Gantt.
2. Open the List Column Section menu, and click Fields.

3. Use the Show and Display fields and select columns or a combination of both to
control what you see in the list. Select the correct option and click Go.

4. Click the Properties icon to change the way a field displays.
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5.
6.

Enter a new value in the Column Label field to change a field label.

Save your changes.

Add an Image to a List Portlet

You can add an image that links to another page. New virtual attributes like an image
are automatically displayed in the far right column of the list. You can move the virtual
attribute to a different position in the List Column layout.

Follow these steps:

1.
2.
3.

Open the Options menu that appears on the portlet toolbar, and click Configure.
Open the List Column Section menu, and click Fields.

Click New.

Select Image, and click Next.

Complete the requested information in the General section. The following fields
require explanation:

Image

Specifies the image to use in the grid column.
Link

Specifies a page link that appears as a secondary value that the user can select.
Open as Pop-up

Indicates whether the target page of the image link appears as a pop-up.

Save your changes.

Add a Progress Bar to a List Portlet

A progress bar shows progress over time. New virtual attributes like the progress bar
are automatically displayed in the far right column of the list. You can move the virtual
attribute to a different position in the List Column layout.

Follow these steps:

1.
2.
3.

Click the Options icon that appears on the portlet toolbar.
Open the Options menu, and click Configure.
Open the List Column Section menu, and click Fields.

Click New.
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5. Select Progress Bar, and click Next.
6. Complete the requested information. The following fields require explanation:
Current Stage Name

Specifies the field value to use for each stage in the progress bar. The value
displays below the column label.

Current Stage Number
Specifies the field value to use for the current stage in the progress bar.
Number of Stages

Specifies the field value that defines the total number of stages in the progress
bar.

Show Label

Indicates whether the name of the current stage is displayed in the progress
bar.

7. Saveyour changes.

Add a Time Scaled Value to a List Portlet

You can set up a time-scaled value on a list portlet to show a value for a specific period.
This value is based on a time-varying attribute for which a user enters values in CA
Clarity PPM. As a user you cannot create a time-varying attribute. Only an administrator
with the appropriate rights can create a time-varying attribute.

You can display multiple time-scaled values in a list portlet. The data for the attributes
displays as stacked on the page, with the information for each time-scaled value
appearing in the same virtual column. The data that displays can be in units of money,
numbers, or percentages.

New virtual attributes such as a time-scaled value are automatically displayed in the far
right column of the list. You can move the virtual attribute to a different position in the
List Column layout.

Follow these steps:

1. Click the Options icon that appears on the portlet toolbar.

2. Open the Options menu, and click Configure.

3. Open the List Column Section menu, and click Fields.

4. Click New.

5. Select Time Scaled Value, and click Next.
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6. Complete the requested information in the General section. The following fields
require explanation:

Value Attributes

Indicates the time scaled values that display in the virtual column. Select the
attributes in the Available list box and use the arrows to move the attributes to
the Selected list box.

Secondary Value

Specifies an additional (second) value for a time-scaled value virtual column
that displays as a tooltip when you mouse over the value in the column.

Link

Specifies a page link that appears as a secondary value that the user can select.
Open as Pop-up

Indicates whether the target page of the image link appears as a pop-up.
Show Legend Label

Indicates whether the field label appears next to the time-scaled value in the
virtual column. Select the check box to display the field label.

Show Column Label
Indicates whether the column label appears at the top of the column list.

7. Complete the requested information in the Time Scale section. The following fields
require explanation:

Start Date
Indicates the start date for the time period for the virtual-scaled value.

Note: The Other Date option appears only if you select a start date for a
time-scaled value for a subobject. This field lets you select a field from the
master object on which to base the start date. This option only appears when a
subobject has time-scaled value attributes.

Time Scale
Specifies the length of time the time-scaled value covers.
Values:

m  Specific Time Scale. Indicates by naming a specific length of time what the
period for the time-scaled value is.

m  Other Time Scale. This option appears only if you select a time scale for a
time-scaled value for a subobject. The field lets you select a field from the
master object on which to base the time scale.

Number of Time Periods

Defines the number of time periods to be reported in the virtual column.
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Time Period Offset

Defines the number of time periods you want to shift the beginning of the
time-scaled value relative to the Start Date. Enter a Start Date value to use this
option.

Show Group Row Header

Specifies a timescale to be displayed above the virtual column. Select the check
box to display a timescale and select the period type you want from the
drop-down list.

8. Complete the following fields in the Display section. The following term requires
explanation:

Decimal Places

Defines the number of decimal places to return for the attribute. To specify the
attribute as an integer, enter a zero (0).

9. Save your changes.

Add an Aggregation Row for a Number Field to a List Portlet

An aggregation row shows statistical data for money or number fields that display in the
aggregation row. You can choose from a number of mathematical functions to apply to
the individual fields you select for the row. You can choose maximum, minimum,
average, sum, count, standard deviation, and variance.
Follow these steps:
1. Click the Options icon that appears on the portlet toolbar.
2. Open the Options menu, and click Configure.
3. Open the List Column Section menu, and click Aggregation.
4. Click Add.
5. Complete the requested information:

Label

Defines the name for the aggregation row.
Show

Determines whether the name of the aggregation row is displayed. Select the
check box to display the name.

Attribute

Specifies the field value that is used for the aggregation. All fields that you have
selected for the grid portlet are present for selection but do not have to be
included in the aggregation row.
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6.

Function

Specifies the aggregation function that is used to calculate values for a selected
field (cell) in the row.

Save your changes.

Display an Aggregation Field as a Bar or Column Graph

You can display a field in an aggregation row as a number, bar graph, or a column graph.
By default, the field displays as a number when it is first added to the aggregation row.
The following procedure describes how to display an aggregation field as a bar or
column graph.

This procedure assumes that the aggregation row with number fields has been created.

Follow these steps:

1.
2.
3.

Click the Options icon that appears on the portlet toolbar.
Open the Options menu, and click Configure.
Open the List Column Section menu, and click Aggregation.

In the Display row, click the word that appears below the column whose display you
want to change.

Select the display type, and click Save and Return.

If you select bar or column graph, these words appear at the bottom of the column
in the Display row.

To complete the setup for a bar or column graph, click Bar Graph or Column Graph
in the Display Row to complete the additional fields.

Complete the requested information in the Primary Column section. The following
fields require explanation:

Maximum Length

Defines the maximum length that the graph can be as a column or bar in pixels.
Length Scaling

Specifies what is used as the basis for scaling if you want the graph scaled.
Threshold Line Attribute

Specifies the field to be used to calculate a threshold for the graph.
Threshold Aggregation Function

Specifies the mathematical function that is used to calculate a threshold for the
graph.
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Over-threshold Color

Specifies the graph color used to indicate when the threshold has been
exceeded.

Complete the requested information in the Stacked Column section to stack a
second aggregation field value in the column of the list portlet.

Stacked Attribute

Specifies the second field value to be displayed as a bar or column graph in a
column.

Save your changes.
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Chapter 7: How to Configure a Chart Portlet

You can use the three-dimensional and animation charting capabilities to organize and
visually represent complex information. You can use charts to:

m  Mouse over data points to view additional information about dimension values and
metrics.

m  Drill down to view details on a data point on the chart.

m  Slice a pie or a funnel chart to call out information.

m  Assign colors and change X and Y-axis labels.

You can display charts from any portlet page, such as the Overview page or dashboards.

You can add charts by personalizing pages or your CA Clarity PPM administrator can add
charts using Studio.

For more information, see the Studio Developer’s Guide.
You can print, slice, or can rotate charts by setting chart options.

Right-click a chart to set the following chart options:

m  Print. Prints the chart.

m  Slicing. Extracts slices from a pie or a funnel chart. Slicing is the default setting.

m  View 2-D. Temporarily changes to a two-dimensional view of the chart. When you

leave the chart portlet page and return, the chart view is three-dimensional.

The following table describes the available options for each chart.

Chart Type View 2-D Slicing Rotation
Area Yes No No
Bar No No No
Bubble No No No
Column Yes No No
Funnel Yes Yes No
Line Yes No No
Pie Yes Yes Yes
Scatter Yes No No
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You can complete the following tasks to personalize a chart portlet:

m  Determine the appearance of a chart portlet (see page 62)

m  Determine the source data for a chart portlet (see page 67)

m  Configure for consistent chart colors (see page 67)

m  Apply or remove consistent chart colors (see page 68)

Determine a Chart Portlet's Appearance

The following procedure explains the basic steps to determine the appearance of any

chart. This procedure assumes the basic chart has been created and the data that the
chart is to show has been chosen.

All fields that occur for any chart type are included but are marked by the type of chart
to which the fields apply.

Follow these steps:

1. Open Administration, and from Studio, click Portlets.

2. Select the Type as Filter/Graph to search for the portlet.

3. Open thefilter portlet, and from the Chart Section menu, click Options.

Select the part of the chart for which you want to set options in the Options field.

5. Complete the requested information depending on the type of chart you select. The

following fields require explanation:

Note: The fields are listed in alphabetical order rather than the order they appear
on the page.

Allow Configuration
Indicates that users can modify the appearance of a portlet.
Allow Label Configuration
Indicates that users can modify portlet labels.
Angle of First Slice
Defines the position of the first dividing line. Use with Pie and Funnel charts.
Values: 0 to 360 degrees
Default: 0
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Axis Label

Displays the metric name along the X-axis, Y-axis, or both axes. Use this option
with:

m  Bar. X-axis, Y-axis.

m  Column. X-axis, Y-axis.

m Line. X-axis, Y-axis.

m  Bubble and Scatter. X-axis.
Crosses Opposite Axis At

Defines the intersection point of the axis. Use with bubble and scatter charts.
Category Labels

Specifies the labels that appear along the category axis for the X-axis of column
and line graphs and the Y-axis of bar graphs. For example, consider a column
graph that shows five months of data with three metrics (shown as red, green,
and blue bars). The months are the categories, and this field determines the
label that appears on each one.

Datapoint Labels

Specifies the data name that appears next to the value on the chart. Use this
option with all data types.

Decimal Places

Defines the number of decimal places to display for numbers. Use this option
with:

m  Bar. X-axis.

m  Column. Y-axis.

m  Line. Y-axis.

m Bubble and Scatter. X-axis, Y-axis.
Display Units

Specifies how values are rounded up. Select a value for rounding from the
drop-down list. Use this option with:

m  Bar. X-axis.

m  Column. Y-axis.

m  Line. Y-axis.

m Bubble and Scatter. X-axis, Y-axis.
Filter

Indicates how the results appear initially on a page.
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Link
Specifies a page link that appears as a secondary value that the user can select.
Major Unit Increment

Defines the interval of major ticks on the axis. Use this option with:

m  Bar. X-axis.

m  Column. Y-axis.

m  Line. Y-axis.

m Bubble and Scatter. X-axis, Y-axis.

Maximum Value

Defines the greatest value to display on the axis. Use this option with:

m  Bar. X-axis.

m  Column. Y-axis.

m  Line. Y-axis.

m Bubble and Scatter. X-axis, Y-axis.

Mouseover Labels

Specifies the data values to show when a user moves the cursor over a chart
value. Use with all chart types.

Other Category Threshold

Defines the data point at which all records for a specified value are grouped
into a category named Other. Use this option if too many items appear on the
chart. Use this option with the following chart types:

m  Bar

m  Column

m Line

m  Pie and Funnel
Show Axis

Indicates whether the Axis line displays. Use this option with:

m  Bar. X-axis, Y-axis.

m  Column. X-axis, Y-axis.

m Line. X-axis, Y-axis.

m Bubble and Scatter. X-axis, Y-axis.
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Show Legend

Specifies whether to display a legend for the chart. Use with bar, column, line,
bubble, and scatter chart types.

Default: Selected
Show Line Markers

Indicates data points on the chart; otherwise, only a line displays. Available for
line charts. Select the check box to show line markers.

Show Lines
Indicates that lines are to connect the data points. Available for line charts.
Show Major Grid Lines
Indicates whether major grid lines display on the chart. Use this option with:
m  Bar. X-axis, Y-axis.
m  Column. X-axis, Y-axis.
m Line. X-axis, Y-axis.
m Bubble and Scatter. X-axis, Y-axis.
Show Separator

Specifies that a comma is to separate values greater than 999 (for example,
1,000). Use this option with:

m  Bar. X-axis.
m  Column. Y-axis.
m  Line. Y-axis.
m Bubble and Scatter. X-axis, Y-axis.
Show Tick Labels
Indicates whether tick labels display on the chart. Use this option with:
m  Bar. X-axis, Y-axis.
m  Column. X-axis, Y-axis.
m Line. X-axis, Y-axis.
m  Bubble and Scatter. X-axis, Y-axis.
Show Title
Indicates that the portlet name is to display. Available for all chart types.
Sort Column

Indicates that a column is the default sort item. This option is available for
column and line charts.
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Sub-type

Indicates the metrics that display as separate bars rather than a single merged
bar. Select the sub-type that is desired. This option is available for bar and
column charts.

Tick Label Angle
Sets the angle of a label that is used with tick marks. Use this option with:
m  Bar. X-axis.
m  Column. X-axis.
m Line. X-axis.
m  Bubble and Scatter. X-axis.

6. (Optional) To configure a line chart, select Guides in the Options field and click New.
Complete the following fields and save your changes:

Axis
Specifies the axis for which guides are being set.
Label
Defines the name for the axis. Enter the name that you want to appear.
Show Label
Determines whether the name of the axis displays.
Type

Identifies the source of the information that displays on the guide. Select the
appropriate option. If you are selecting a type for an X-axis, you can only select
an attribute. If you are selecting a type for a Y-axis, select either the fixed value
or the percent value and enter the amount.

Default: Attribute
Color
Specifies the color for the guide.

Default: Black
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Determine a Chart Portlet's Source Data

This procedure explains how to determine which data displays on a chart.

Follow these steps:

1. Open Administration, and from Studio, click Portlets.

2. Select the Type as Filter to search for the portlet.

3. Open the filter portlet, and from the Chart Section menu, click Source Data.
4. Select the metrics that you want to include in the chart.
5

Save your changes.

Configure for Consistent Chart Colors

If your administrator selects the Use Consistent Chart Colors option at the system level,
you can configure a chart portlet to:

m  Use consistent colors

m  Use a consistent color key when assigning colors to a chart portlet. If you select a
key, the color palette (out-of-the-box or custom) assigns colors that are based on
the key.

Follow these steps:

1. Open a page that contains the chart to modify.

2. Open the Options menu and click Configure.

3. Complete the requested information. The following fields require explanation:
Consistent Color Key

Specifies the consistent color key. The list of available keys depends on the
source data of the specific chart.

Use Consistent Colors Select
Specifies overriding the selection (for this chart only) at the system level.
Values: Yes or No

4. Save your changes.
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Apply or Remove Consistent Chart Colors

CA Clarity PPM administrator can enable the Use Consistent Chart Colors option at the
system level. In this case, you can switch between applying and not applying consistent
colors at the chart level. The ability gives you flexibility when the colors assigned to the
chart make it unreadable. For example, more than one data set displays the same color.
Toggling between states of color is useful when charts with multiple metrics are used
and the legend displays only one color.

If consistent colors are currently applied to a chart, you can switch to the Default Colors
(inconsistent colors) option. Conversely, if you do not apply consistent colors to a chart,
you can switch to the Consistent Colors option in the Options menu.

The changes that you make at a chart portlet level during a CA Clarity PPM session are
only available in that session. Once you log out, the changes are lost. For the changes to
be available outside a session, configure the chart portlet.

Follow these steps:

1. Open a page containing the chart to modify.

2. Select Consistent Colors or Default Colors from the Options toolbar for the chart
portlet.

The option that is available depends on the current chart setting (Default or
Consistent).
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You can personalize a filter portlet in the following ways:

m  Add a Field to a Filter Portlet (see page 69)

m  Add a Lookup or Multivalued Lookup Field to a Filter Portlet (see page 70)

m  |ay Out Fields on a Filter Portlet (see page 72)

Add a Field to a Filter Portlet

This procedure explains how to add a field to a filter portlet.

Follow these steps:

1. Open Administration, and from Studio, click Portlets.
2. Select the Type as Filter and search for the portlet.
3. Open thefilter portlet, and click Fields.

4. Click Add.

5. Complete the requested information. The fields can vary depending on the Data
Type you select. Not all fields listed appear for each data type.

Data Type

Specifies the data type for the field. Once you save, you cannot change the data
type.

Show as Percent
Indicates if the value entered in the field displays as a percent.
Filter Default

Specifies the value that appears as the default value in the filter field. If the
filter portlet associated with this field is published to a dashboard as the filter
default, this value is applied to the portlet attributes mapped to this field.

Width

Defines the width of the field. If you leave the field blank, the field receives the
default, which is 30 pixels. The default for date fields is 20 pixels.

Required in Filter

Specifies that a value is required in the field when a filter request is executed. If
you select this check box, enter a value in the Filter Default field.
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Hidden in Filter

Specifies that the field does not display in the filter at runtime, but the default
value of the field is included when you execute a filter request. Select the check
box to hide the field in the filter.

Read-Only in Filter

Specifies that the field displays with a default value that you cannot edit. Select
the check box to make the field read-only in the filter.

Hint
Defines a short message that helps a user use the field.

Limits: 512 characters

6. Save your changes.

Add a Lookup or Multi Valued Lookup Field to a Filter Portlet

Use the following procedure to add a lookup or multi valued lookup field to a filter
portlet. Lookup fields display a drop-down or a browse list from which users can select
items.

Follow these steps:

1. Open Administration, and from Studio, click Portlets.

N

Select the Type as Filter and search for the portlet.

3. Open the filter portlet, and click Fields.

4. Click Add.
5. Complete the requested information. The following fields require explanation:

Data Type

Specifies the data type for the field. When you select Lookup or Multi Value
Lookup, the fields on the page change to reflect the lookup you select and its
data source (static or dynamic).

Display Type
Specifies how the field is to be used by to the user.
Lookup

Specifies a list of lookup values that appears in the field for the user to select.
The user views the list according to the display type selected.
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Some of the fields that are listed in this section may not show on your page.
Lookup Style

Indicates how many items a user can select for the field when the lookup is
executed.

Entry

(Static dependent lookup lists only). Defines the starting point for the data a
user sees listed in the lookup field. Select a level in the Level field or select a
parent lookup value.

Exit

(Static dependent lookup lists only). Defines the end point of the data a user
sees listed in the lookup field.

Filter Default

Specifies the value that appears as the default value in the filter field. If the
filter portlet associated with this field is published to a dashboard as the filter
default, this value is applied to the portlet attributes mapped to this field.

Required in Filter

Specifies that a value is required in the field when a filter request is executed. If
you select this check box, enter a value in the Filter Default field.

Hidden in Filter

Specifies that the field does not display in the filter at runtime, but the default
value of the field is included when you execute a filter request. Select the check
box to hide the field in the filter.

Read-Only in Filter

Specifies that the field displays with a default value that you cannot edit. Select
the check box to make the field read-only in the filter.

Hint
Defines a short message that helps a user use the field.

Limits: 512 characters

If you selected a parameterized lookup in the Lookup field, complete the mappings
in the Lookup Parameter Mappings section. This section is visible only for
parameterized lookups.

For more information, see the Administration Guide.

Save your changes.
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Lay Out Fields on a Filter Portlet

This procedure explains how to determine the placement of the fields within the filter
portlet when it is rendered on a portlet page. Use this procedure after you have created
the filter portlet and its fields.

The displayed list order of fields is how the fields appear in the Section view on a portlet
page. If the Toolbar view is selected for the filter portlet, the fields display in a different
order. The left column is equivalent to the top row and the right column is equivalent to
the bottom row on the portlet. The left and right columns represent where the fields
display on the portlet page.

Follow these steps:

1. Open Administration, and from Studio, click Portlets.

2. Select the Type as Filter and search for the portlet.

3. Open the filter portlet, and click Layout.

4. Move the fields to the appropriate list box (Left Column or Right Column) using the
arrows in the Layout section. The order you place the fields in the list boxes is the
order of appearance in the filter portlet.

To reorder the fields, highlight the field and click the up and down arrows to move
it in the list.

5. Complete the requested information in the Settings section. The following fields
require explanation:

Render As

Indicates how you want the filter portlet to appear on the published page or
dashboard. Select Toolbar or Section. If you select Toolbar, the default filter
state is fixed as Expanded.

Default Filter State

Indicates whether the filter portlet is to display on the dashboard as expanded
or collapsed.

6. Save your changes.
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Chapter 9: How to Create and Manage
Discussions

This section contains the following topics:

Introduction to Discussion (see page 73)

Create a Discussion Topic (see page 73)

Post a Message to a Discussion Topic (see page 74)
Post a Reply to a Message (see page 74)

Expand or Collapse a Discussion Thread (see page 75)

Introduction to Discussion

Use the Discussion feature to exchange ideas and communicate in a common location
on subjects relevant to the participating resources. This feature allows its users to post
discussion topics and reply to topics and messages. Users with the appropriate access
rights can access Discussions from within certain objects. This feature is available from
the following locations:

®m  Projects and Programs
®  Requisitions

For more information about managing resources, see the Resource Management
User Guide.

Create a Discussion Topic

Only a collaboration manager can create new discussion topics. By default, the user who
creates projects or programs is the collaboration manager. You can designate additional
collaboration managers.

An author cannot change the topic or message content once it is posted. Only a
collaboration manager for the specified investment can delete discussion topics and

messages.

For more information, see the Project Management User Guide.
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Follow these steps:
Open Home, and from Portfolio Management, click Programs or Projects.
Click the name of the program or project.

Click Collaboration, open the Collaboration menu, and click Discussions.

Ll

Click New.

5. Complete the requested information, and click Submit.

Post a Message to a Discussion Topic

This procedure explains how to post a message to a discussion topic.

Follow these steps:

1. Open Home, and from Portfolio Management, click Programs or Projects.
2. Click the name of the program or project.

3. Click Collaboration, open the Collaboration menu, and click Discussions.
4. Click the name of the topic to which you want to respond.

5. Click New.

6. Complete the requested information, and save your changes.

Post a Reply to a Message

This procedure explains how to post a reply to a message.

Follow these steps:

1. Open Home, and from Portfolio Management, click Programs or Projects.
2. Click the name of the program or project.

3. Open the Collaboration menu, and click Discussions.

4. Click the name of the message to reply.

5. Click New.

6. Complete the requested information, and click Submit.

The message that you created displays in the replies list. To return to the original
message or to the list of topics, click the appropriate link at the top of the list.
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Expand or Collapse a Discussion Thread

You can expand a thread to view all of the replies to a message and collapse it back to
the message level.

Expanding a thread

When you expand a thread, you can see the expanded view of the message you
selected. To expand a thread, select the message or reply whose contents you want to
view, and click Expand.

Collapsing a thread

When you collapse a thread, the message or reply displays only its subject line. To

collapse a thread, select the message or reply whose contents you want to collapse, and
click Collapse.
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Chapter 10: How to Work with Folders and
Documents

This section contains the following topics:

Introduction to the Knowledge Store and Document Manager (see page 77)
Knowledge Store Access Rights (see page 78)

Knowledge Store and Document Manager Permissions at the Folder and Document
Levels (see page 79)

How to Create a Folder (see page 80)

How to Manage a Folder (see page 81)

How to Manage Documents (see page 84)

Introduction to the Knowledge Store and Document Manager

You can access and manage your documents from two repositories:
m  The Knowledge Store

®  Document Manager

Your administrator maintains the Knowledge Store and Document Manager. These
repositories contain documents on policies or procedures that pertain many people.

You can use the Knowledge Store to save and access your generic documents. You can
use Document Manager to build a repository for project or program-related forms and
documents. You can also attach documents, such as a resume or an application form, to
a resource profile.

Though most users can access these repositories, their access to the folders and
documents within it vary. With the appropriate permissions, users can create folders,
add documents to them, and edit both documents and folders. The key differences exist
in the access rights of the two repositories.

To access the folders to which you have access, open Home, and from Organization,
click Knowledge Store.

Note: If you do not see the Knowledge Store link, contact your CA Clarity PPM
administrator for access.
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Knowledge Store Access Rights

Access to the Knowledge Store and its folders and documents are provided at the
following levels:

m  Access rights at the Knowledge Store level

m  Permissions at the folder and document levels

The following rights to access are required to manage or view content in the Knowledge

Store:

Access Right Description

Knovylc.edge Store - m  Allows you to access all of the folders and documents
Administrate in the Knowledge Store.

m  Only users with the Knowledge Store - Administrate
right can create folders at the top level of the
Knowledge Store folder tree.

m  Users with the Knowledge Store - Access right and
with the appropriate permissions can add sub folders
and documents to the folders.

Knowledge Store - Access g Allows you to create, edit, and view documents and
folders in the Knowledge Store to which you have
access.

m  Allows you to delete the folders you created, and the
documents you added.

Knowledge Store - View All g Ajlows you to view all documents in the Knowledge
Store.
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Knowledge Store and Document Manager Permissions at the
Folder and Document Levels

The CA Clarity PPM administrator grants the Knowledge Store access rights. Access to
folders and documents are granted on a case-by-case basis. When you create or
administer a folder or document, identify the users who need access to the folder or
document. Then, give the users permission to read, read/write, or read/write/delete the
folder or document. The permission level determines the actions users can take on a
folder or document.

Permission Description

Read You can do the following:
m  Open current and prior versions of a document.

m  Check out current and prior versions of a document.

Read/Write You can do the following:
m  Open, read, copy, and move documents.
m  Check in or check out documents.
m  View check in/check out history.
m  View document versions.

m  View and modify document properties and
permissions.

m  Attach processes for documents.

m  Add new folders and documents.

Read/Write/Delete You have all the read/write permissions, plus you can
move and delete documents and folders.

All Document Manager participants are automatically given the read permission. The
project manager, program manager, resource manager, or CA Clarity PPM administrator
grants the other permissions.
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How to Create a Folder

Folders can stand alone and can contain documents, or a folder can serve as a top-level
folder that contains subfolders. Both top-level folders and subfolders can contain
documents.

To view the list of folder actions, from a Knowledge Store or Document Manager page,
click a folder Actions menu. Your access rights and permissions determine the actions
that display. Only if you have the appropriate access for a particular action, that action
appears in the Actions menu for a folder.

You can create subfolders for a top-level folder, and subfolders for a subfolder. When
you create a subfolder, the application automatically gives read/write access to that
subfolder to those resources you selected at the top level. These resources are named
participants. You can select individual resources from the existing participant group and
can give access to more users.

Create a Folder for a Project or Program
This procedure explains how to create a folder for a project or a program.

Follow these steps:

1. Open Home, and from Portfolio Management, click Projects or Programs.
2. Open the project or program, and click Collaboration.

3. Select New Folder from the folder Actions menu.
4

Complete the requested information and save your changes.
Create a Folder for a Resource
This procedure explains how to create a folder for a resource.

Follow these steps:
Open Home, and from Resource Management, click Resources.
Open the resource or role, and click Document Manager.

Select New Folder from the folder Actions menu.

Eal S

Complete the requested information and save your changes.
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How to Manage a Folder

You can manage a folder in the following ways:

Add a Document to a Folder (see page 81).

Download Files from Folders (see page 82).

Edit the Folder Properties or Permissions (see page 83).

Add a Document to a Folder

You can add a maximum of five files to a folder at one time.

Follow these steps:

1.

Open the Knowledge Store page for a specific program or project, or the Document
Manager page for a resource.

Open the Actions menu for the folder, and click Add Documents.

Select the files to add and complete the requested information. The following fields
require explanation:

Enable Check Out

Indicates if resources with appropriate access can check out and can edit the
file.

Enable Versioning

Indicates if resources with appropriate access can create another version of the
file.

Click Add.
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Download Files from Folders

Use the Download All or the Incremental Download option to download files from a
selected folder to a local zip file. The absence of these options on the Actions menu
implies that you do not have the required permissions to download the files.

You can download:

m  All the files and subfolders in a selected folder

m  Asubset of files from the selected folder. The subset includes those files that have

changed since you last downloaded and those files not yet downloaded.

The zip file name is the name of the folder by default. You can select where to download
the file. When you download files from a folder, the file structure is not maintained in
the saved zip file.

Important! Enable the Enable Document Download setting before you download files.

For more information, see the Administration Guide.

Download All Files

This procedure explains how to download all the selected files, including files in
subfolders.
Follow these steps:

1. Open the Knowledge Store page for a specific program or project, or the Document
Manager page for a resource.

2. Open the Actions menu for the folder, and click Download All.
The File Download window opens.

If the size exceeds the maximum for download set by your administrator, download
a subset of files from the folder.

3. Save the zip file.

Download Files Incrementally

This procedure explains how to download a subset of files from a selected folder. The
zip file includes only files that have changed since you last downloaded them and files
not yet downloaded.
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The file structure is not maintained in the saved zip file.

Follow these steps:

1.

Open the Knowledge Store page for a specific program or project, or the Document
Manager page for a resource.

Open the Actions menu for the folder, and click Incremental Download.
The File Download window opens.

If the size exceeds the document download maximum set by your administrator,
download one file at a time.

Save the zip file.

Edit the Folder Properties or Permissions

When you add resources to a folder, they are automatically grouped as participants with
read/write access to this folder. The user who creates the folder is automatically given
read, write, and delete access to the folder. You can change the permissions at any time.

Follow these steps:

1.

Open the Knowledge Store page for a specific program or project, or the Document
Manager page for a resource.

Open the Actions menu for the folder, and complete one of the following steps:
m  Click Properties to edit the folder properties.
m  Click Permissions to edit the folder permissions.

Note: Select Cascade Permissions to allow a resource to transfer the rights to any
documents and subfolders in the current folder.

Save your changes.
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How to Manage Documents

While you can check out a document to edit it, you can also open it in read-only mode
for viewing purposes only.

You can manage your documents in the following ways:

m  Check Out Documents (see page 84).

m  Edit the Document Properties and Permissions (see page 85).

m  Review the Document History.

m  Copy or Move a Document (see page 85).

m  Delete a Document.

m  Work with Document Versions (see page 86).

m  Work with Document Processes (see page 86).

Check Out Documents

Check Out

Undo Check Out

To edit a document, check it out of a folder. When you are finished, check the document
back in. If the document versioning is enabled, another version of the document is
created automatically.

Other users cannot edit a checked-out document until you check it in. Enable the
document for check out before you can proceed.

This procedure explains how to check out a document.

Follow these steps:

1. Open the Knowledge Store page for a specific program or project, or the Document
Manager page for a resource.

2. Locate the document, and from the document Actions menu, click Check Out.
3. Save the document to your desktop, and select a location for the file.

4. Click OK.

Only the user who checked out the document originally can undo a check out. Undoing
a check out unlocks the document, allowing others to check out the document.

Select Undo Check Out from the document Actions menu to undo a document check
out.
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Check In

Click Check In from the document Actions menu. Browse for the updated copy in the
location that was selected when you checked out the document.

Edit the Document Properties or Permissions

The user who added the document can update the document properties. This procedure
explains how to edit the document properties and permissions:

Follow these steps:

1.

Open the Knowledge Store page for a specific program or project, or the Document
Manager page for a resource.

Open the Actions menu for the document, and complete one of the following steps:
m  Click Properties to edit the folder properties.
m  Click Permissions to edit the folder permissions.

Save your changes.

Copy, Move, or Delete a Document

This procedure explains how to copy, move, or delete a document.

Follow these steps:

1.

Open the Knowledge Store page for a specific program or project, or the Document
Manager page for a resource.

Locate the document to copy or move to a different folder, and from the document
Actions menu, complete one of the following steps:

m  Click Copy.
m Click Move.
Select the destination folder in the Select Placement section.

Select the Notify Resources/Groups check box for users with access to this
document notified about the copy action.

Click Copy.
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Work with Document Versions

You can use the document versioning to save a separate version of a document each

time you check it in. To use the document versioning, enable the document for

versioning.

When you enable versioning, you can:

m  Open and view the previous versions of a document, but you cannot modify it.

m  Copy a specific version of a document to a different folder. You require the
permissions to revise the document after copying it.

Follow these steps:

1. Open the Knowledge Store page for a specific program or project, or the Document
Manager page for a resource.

2. Locate the document, and from the document Actions menu, click Versions.

3. Open the document version Actions menu, and complete one of the following
steps:

m Select Open.

m  Select Copy.

Work with Document Processes

Document processes can be effective when routing a document through an approval
process. Processes are effective because a document process can link to any associated
project or program. You can send notifications and action items from the document
process to the project roles and resources.

The Available Processes page lists all the document-related processes that your CA
Clarity PPM administrator has created. You can use this page to start or delete a
process. The Initiated Processes page lists the in-progress or completed processes. You
can use this page to cancel a process.

To view the Available or Initiated Processes page, open the Knowledge Store, and from
the document Actions menu, click Processes.

Note: For more information, see the Administration Guide.

The steps to start, cancel, and delete document processes from a Document Manager
page are similar to the steps described in this section.
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Follow these steps:

1. Open the Knowledge Store page for a specific program or project, or the Document
Manager page for a resource.

2. Locate the document, and from the document Actions menu, click Processes.
3. Click Available.
4. Select the process and complete one of the following steps:

m  Click Start.

m Click Delete.
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Chapter 11: How to Create, Configure, and
Manage a Dashboard

This section contains the following topics:

Introduction to Dashboards (see page 89)
Review the Prerequisites (see page 93)

Plan the Dashboard (see page 94)

Create a Dashboard (see page 94)

Configure the Dashboard Layout (see page 95)
Manage the Dashboard (see page 97)

Introduction to Dashboards

You can use the personal dashboards to display the specific information you want to
see. The personal dashboards help you perform the following tasks:

m  Create custom portlets for a personal dashboard. If you have the appropriate access
rights, you can use stock portlets.

m  Create a tabbed dashboard for additional pages, if you have more portlets than you
want to show on one page.

m  View dashboards that other users have shared with you.

m  Export dashboard content or an individual portlet in a dashboard to Microsoft Excel
or PowerPoint.

Dashboard and Portlet Differences

The following table highlights the functional differences between a dashboard and
portlet page.

Functionality Dashboard Portlet Page

Exported Output m Fit to page m Fitto page

m  One portlet per slide or
sheet

Sharing with specific
users

m  Yes m No
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Functionality Dashboard Portlet Page
Page type m  Page with tabs m  Page with tabs

m Page without tabs m Page without tabs
Portlet layout m  Two-column templates m  Two-column templates

m  Three-column templates m Three-column
templates

= Row layout

Dashboard Examples

The following examples show how team members and a team manager can use a
dashboard.

Example: Monitoring Project Status

Karen, a team member who tracks the project information for multiple projects, creates
a dashboard with tabs. From the details page of the new dashboard, she creates the
portlets to show the dashboard data. The portlets include the following information:

m  Project Risks
= Budget
m  Resource Allocation

m  Milestones

She configures her dashboard by determining which portlets to present on each tab.
Then, Karen adjusts the layout of portlets on each tab by dragging-and-dropping the
portlets into position on the tab layout section. She adds a filter that gives her the ability
to filter information for all of the portlets at the same time. When the dashboard is
complete, she views the dashboard, filters for the information that she wants, and
exports a copy to PowerPoint as a test.

Before each weekly team meeting, she views the dashboard to monitor her projects,
exports the results to PowerPoint, and provides the information to her team leader. The
team leader includes the PowerPoint slides in the regular team meeting agenda to
provide status.
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Example: Completing Development Tasks and Fixing Software

Roberto, a team member who does not have the right to create dashboards, navigates
to Dashboards. Roberto can see two dashboards that his team manager shares with
him: Security Development Team and Weekly Time Entries. Roberto views the Security
Development Team dashboard. He sees that he has five assigned development tasks
and three software bugs. He clicks the first task to get more information and starts
working on the task.

Example: Sharing a Dashboard with an OBS Development Unit

Stan, the team manager creates a dashboard with two tabs: Team Work and Team
Status. He populates the tabs with portlets created beforehand and with stock portlets
to which he has access. Stan adds the following portlets:

m  Team Members

m  Bugs and Issues by Components

m  Tasks by Team Member

m  Time Entries by Team member

m  Work Completed and Work Remaining

Stan does not allow others to personalize his dashboard. He shares the dashboard with

the entire OBS development unit and the executive management team to view portlets
in the dashboard.
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The following diagram describes how a user creates, configures, and manages a
dashboard:

How to Create, Configure, and Manage a Dashboard

Review the Prereqguisites

:

Plan the Dashboard

:

Create a Dashboard

.

Configure the Dashboard

:

Manage the Dashboard

Lser

Complete
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Review the Prerequisites

Follow these steps:

1
2
3.
4

Review the Prerequisites (see page 93).

Plan the Dashboard (see page 94).

Create a Dashboard (see page 94).

Configure the Dashboard Layout (see page 95).

m  Configure the Dashboard Without Tabs (see page 96).

m  Configure the Dashboard With Tabs (see page 96).

m AddaTab to the Dashboard (see page 96).

m  Add a Portlet to the Dashboard (see page 97).

Manage the Dashboard (see page 97).

m  Share the Dashboard (see page 98).

m  Assign Manager Rights to a User (see page 98).

m Personalize the Shared Dashboard (see page 99).

m  Publish the Dashboard (see page 99).

m  Export the Dashboard (see page 100).

m  Export the Portlet (see page 100).

m Remove a Portlet from the Dashboard (see page 101).

Review the Prerequisites

These prerequisites are necessary to create, configure, and manage a dashboard:

m  Global Access Rights Assigned. Your CA Clarity PPM administrator assigns you these
required global access rights to work with dashboards and portlets.
Access Right Description
Dashboard - Create Allows you to create a dashboard.
Dashboard - Navigate Provides access to the Dashboards link in the Personal
menu.
Portlet - Create Allows you to create a portlet.
Portlet - Navigate Provide access to the Portlets link in the Personal menu.
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Access Rights to the Dashboard Information. You must also have access rights to
the information displayed on a dashboard. Access to a dashboard does not
automatically include access to the project information. If you share a dashboard,
the user with whom you share, must also have the right to see the shared
information.

Note: Sharing a dashboard with a user does not automatically ensure that the user can
see the dashboard. The user must separately have the Dashboard - Navigate right
assigned to them so that the Dashboard option appears in the Personal menu.

Plan the Dashboard

Before you set up a dashboard, consider the following points:

The number of portlets you plan to include.
This information helps you to determine if you need tabbed pages.
How the portlets present information.

You can plan for the visual presentation of graphs or the statistical presentation
that is possible with rows and columns.

The users with whom you can share.

Some users do not have rights to the information you are presenting in portlets. In
addition, consider individuals to whom you can give manager privileges for your
dashboard.

Create a Dashboard

2.

When you create a dashboard, you are given the ability to view and manage the
dashboard.

Follow these steps:

1.

Open Home, and from Personal, click Dashboards.

Click New.
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3. Complete the requested information. The following fields require explanation.
Type
Specifies if the dashboard is a single page or tabbed pages.
Note: Select Page with Tabs to add tabs to the dashboard.
Personalizable

Specifies if the users with whom you share a dashboard can change the copy
that appears in their dashboards list. Any personal changes to a dashboard are
local to the user who makes them. The changes are overwritten when the
owner of the dashboard, or a user with administrator privileges publish new
changes.

4. Save your changes.

Configure the Dashboard Layout

A layout template provides a guideline for your displayed dashboard. A template layout
determines the number of portlets appearing in a row and the percentage width for
each portlet position. If a portlet is large (a grid portlet with many columns), it can
exceed the space allotted to it in a row. In this case, the portlet is not truncated.
However, you can accommodate a larger size by moving portlets to another row when
the dashboard displays. As a result, a displayed dashboard does not look exactly the way
you design it in the Content and Layout section.

To lay out a dashboard, select a template layout and then add portlets and drag them to
the position in the Content and Layout section. Use the Dashboard Details page to
complete the dashboard layout. From the details page, you can also complete the
following tasks:

m  Create new portlets.

m  Add portlets that you create and stock portlets to which you have access.

m  Select a layout template.

®  Drag-and-drop portlets into the appropriate positions.
m  View the dashboard.

m  Export dashboard information.

m  Share the dashboard.

You can configure the dashboard layout in the following ways:

m  Configure the Dashboard Without Tabs (see page 96).

m  Configure the Dashboard With Tabs (see page 96).
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Configure the Dashboard Without Tabs

This procedure explains how to add portlets to a dashboard and assumes the dashboard
and portlets are already created.

Follow these steps:

1. Open Home, and from Personal, click Dashboards.

2. Open the details page for the dashboard.

3. Click the Add Portlet icon in the Content and Layout section.

4. Select the check box for each portlet and click Add.

5. Select the layout template.

You can mouseover each template in the list for the column format it represents.
The template that you select determines how many columns appear on the
dashboard and the percentage of the dashboard allotted to each column.

6. Drag-and-drop to arrange the portlets in the order you want.

7. Saveyour changes.

Configure the Dashboard with Tabs

When you create a dashboard, designate the Type as Page with Tabs to add tabs to the
dashboard. If the option is not selected, you cannot add a tab. The following procedure
explains how to add tabs and portlets to a dashboard. The procedure assumes the
dashboard and portlets are already created.

You can use the Content and Layout section to configure a dashboard with tabs in the
following ways:

m  Add atab to the dashboard (see page 96).

m  Add a portlet to the dashboard (see page 97).

Add a Tab to the Dashboard

You can add a tab to the dashboard and can add portlets to that tab. This procedure
explains how to add tabs to a dashboard and assumes the dashboard is already created.
Follow these steps:

1. Open Home, and from Personal, click Dashboards.

2. Open the details page for the dashboard with the Page with Tabs type.

3. Click the Add Tab icon in the Content and Layout section.
4

Complete the requested information and save your changes.
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Add a Portlet to the Dashboard

This procedure explains how to add portlets to a dashboard and assumes the dashboard
and portlets are already created.

Follow these steps:

1. Open Home, and from Personal, click Dashboards.

2. Open the details page for the dashboard.

3. Select the tab to be configured in the Contents and Layout section.

4. Click the Add Portlet icon in the Content and Layout section.

5. Select the check box for each portlet to add to the dashboard, and click Add.
6. Select the layout template.

You can mouseover each template in the list for the column format it represents.
The template that you select determines how many columns appear on the
dashboard and the percentage of the dashboard allotted to each column.

7. Drag-and-drop the portlet icons into the position on the tab.
8. Save your changes.

9. Repeat these steps to configure each tab.

Manage the Dashboard

You can manage the dashboard in the following ways:

m  Share the Dashboard (see page 98).

m  Personalize a Shared Dashboard (see page 99).

m  Publish the Dashboard (see page 99).

m  Export the Dashboard (see page 100).

m  Export the Portlet (see page 100).

m  Remove a Portlet from the Dashboard (see page 101).
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Share the Dashboard

You can share a dashboard with a user, a group of users, or an OBS group. When you
share, the dashboard appears in the user list of dashboards for viewing. By default,
when you share with a user, they have view only rights.

You can also assign manager rights to a user. The rights let the user change and publish
the dashboard to all who can view the dashboard. Give the permission to only a few
trusted users.

You can also allow a user to change the shared copy of the dashboard that appears in
the user dashboard list. The changes apply only to the user version and other users
cannot view them. The changes remain in the user copy until the owner of the
dashboard, or a user with manager rights publishes changes. The latter overwrites all
personalized changes.

Follow these steps:

1. Open Home, and from Personal, click Dashboards.

2. Open the details page for the dashboard, and open the Actions menu, and click
Sharing.

3. Click the appropriate menu to add a resource, group, or OBS unit.

Click Full View to see the names of users who have access to the dashboard through
means other than sharing.

4. Click Add.
5. Select the individuals, groups, and OBS groups with whom you want to share, and

click Add.

Assign Manager Rights to a User
This procedure explains how to assign rights to a user.

Follow these steps:
1. Open Home, and from Personal, click Dashboards.

2. Open the details page for the dashboard, and open the Actions menu, and click
Sharing.

3. Locate the user to assign manager rights for your dashboard on the Resources page.
4. Select Manager from the drop-down in the Access Right column.

5. Save your changes.
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Personalize a Shared Dashboard

You can personalize another user dashboard when shared with you. The changes that
you make are visible only to you and not to other users who view the dashboard on
their computers. If the creator of the dashboard modifies and publishes the dashboard,
your personal changes are lost.

You can personalize:

m  Dashboard name and description.

m  Dashboard content. You can add and remove portlets.

m  Page filters for the portlets.

= Portlet layout.

Follow these steps:

1. Open Home, and from Personal, click Dashboards.

2. Open the details page for the dashboard, open the Actions menu, and click View
Dashboard.

3. Click Personalize.
4. Select the appropriate menu and modify the dashboard.

5. Save your changes.

Publish the Dashboard

A dashboard manager can publish changes to a dashboard. When a dashboard manager
publishes, the new changes affect every user who can view the dashboard. If a user
personalizes the dashboard, the changes are overwritten by the new changes being
published.

Follow these steps:

1. Open Home, and from Personal, click Dashboards.

2. Click the name of the dashboard to change and publish.

3. Change the dashboard, if necessary, and click Save.

4. Click Publish, and then click Yes to publish.
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Export the Dashboard

You can export a dashboard from the details page, or from a dashboard that is displayed
for viewing. You can export the contents of a dashboard or an individual portlet in a
dashboard to Microsoft Excel or PowerPoint. The maximum export size for Excel and
PowerPoint is 300 records. However, there is no limit when you use the Export to Excel
(Data Only) option.

You can fit the exported information to a page in PowerPoint. You can also place each
exported portlet on a separate page. This approach avoids having all the portlets fitted
onto a single page as they appear in a dashboard.

m  To export each portlet to a separate page with the current dashboard size, select
One Portlet per Slide/Sheet.

m  To export each portlet to a separate page and fit the portlet to the page, select both
One Portlet per Slide/Sheet and Fit to Page.

m  To fit all the exported portlets on a single sheet or page, verify that both check
boxes are clear. Some portlets can be truncated if the number of portlets is larger
than the PowerPoint page can accommodate while you export to PowerPoint.

Follow these steps:
1. Open Home, and from Personal, click Dashboards.
2. Open the details page for the dashboard.

3. Select the appropriate check boxes for the Export field, to indicate how you want
the portlets to appear.

4. Open the Actions menu and click Export to Excel or Export to PowerPoint.

Export the Portlet

Display the dashboard for viewing to export an individual portlet. Some stock portlets
are restricted and cannot be exported. If a portlet is restricted, the Export to icon does
not appear in the Options toolbar.

If you are exporting a chart portlet, the chart displays in native the Microsoft Office
chart format.

Follow these steps:
1. Open Home, and from Personal, click Dashboards.

2. Open the details page for the dashboard, open the Actions menu, and click View
Dashboard.
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Open the Options menu on the portlet you want to export and select one of the
following options:

m  Export to Excel (Data Only). Includes the portlet information but does not
include charts.

m  Export to Excel. Includes the portlet information and any portlet charts.
m  Export to PowerPoint. Includes the portlet information and any portlet charts.
The File Download dialog appears.

Click Open to display the file without saving, or click Save to save the file.

Remove a Portlet from the Dashboard

Removing a portlet from a dashboard does not delete it, but remains in your portlets list
page. To delete the portlet permanently, delete it from the portlets list page.

Follow these steps:

1.
2.
3.

Open Home, and from Personal, click Dashboards.
Open the details page for the dashboard.
Click the Remove icon on the portlet in the Content and Layout section.

Save your changes.
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Chapter 12: Global Search Tool

This section contains the following topics:

About the Global Search Tool (see page 103)
Perform a Basic Search (see page 103)
Perform an Advanced Search (see page 104)
Global Search Technigues (see page 104)

About the Global Search Tool

The Global Search tool appears on the global toolbar. Use the global search field to
perform a simple global search to look for specific documents and forms. Use the
Advanced link to set additional search criteria to refine your search results.

You can search for information that is saved in the application at any time. However, by
default, 5 minutes to elapse before new information can be searched. Your
administrator determines and can change the amount of time.

For more information, see the Administration Guide.

Perform a Basic Search

To perform a basic search, click the Search icon and enter all or part of the term, then
click Search. The search results page displays a list of all items that match the specified
criteria. The list contains only items that you have the right to view.

Keep in mind these guidelines when entering terms in the global search field:

m  To perform a wildcard search, enter all or part of the search criteria. You do not
have to append your entry with a wildcard character (*). Basic search is not

case-sensitive. For example, the entries Orange, orange, and ORANGE all return the
same results.

m  [fyou enter the search phrase, Resource Profile List without quotations, the
application searches for items that contain any of these words in any order.
However, if you enter the search phrase in quotation marks ("Resource Profile
List"), only instances of the exact string are returned.

® Do not use the following characters in basic searches:

@=[{}<>
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Perform an Advanced Search

Use the Advanced Search page to set additional criteria to refine your search results.

Use the fields and options on the page to narrow your search. You can search according
to one or any combination of the criteria. The search results display only for those items
you have permissions to view or edit.

Global Search Techniques

Use the following techniques to perform global searches:
m  Wildcard characters
m  Boolean operators

m  Subqueries

Use Wildcard Characters in a Global Search

With the Global Search tool, you can perform single and multiple character wildcard
searches. Do not use the "*" or "?" symbols as the first character of a search.

Single Character Wildcard Search

The single character wildcard search looks for terms that match with the single
character replaced. To perform a single character wildcard search, use the "?"
symbol.

Example: To search for text or test, enter the query:
te?t

Multiple Character Wildcard Search

Multiple character wildcard searches look for zero or more characters. To perform a
multiple character wildcard search, use the "*" symbol.

Example: To search for test, tests, or tester, enter the following text:
test*

You can also use wildcard searches in the middle of a term.

Example:
te*t

104 Basics User Guide



Global Search Techniques

Use Boolean Operators in a Global Search

The Boolean operators let you perform global searches using multiple terms that are
combined through logic operators. The following Boolean operators are supported:
AND, +, OR, NOT, and -.

Enter the Boolean operators in all caps.

OR

OR is the default conjunction operator, which means no Boolean operator exists
between two terms, OR is used. The OR operator links two terms and finds a
matching document if either of the terms exist in a document. This operation is
equivalent to a union using sets. You can use the symbol | | in place of the OR
operator.

Example: To search for documents that contain "jakarta apache" or "jakarta", use
the query:
"jakarta apache" "jakarta"

or,
"jakarta apache" OR "jakarta"

or,
"jakarta apache" || "jakarta"

AND

The AND operator matches documents in which both terms exist anywhere in the
text of a single document. This operation is equivalent to an intersection using sets.
You can use the special character && in place of the AND operator.

Example: To search for "jakarta apache" and "jakarta CA Clarity PPM", use the
query:

"jakarta apache" AND "jakarta CA Clarity PPM"

or,

"jakarta apache" &% "jakarta CA Clarity PPM"

+ (required)

The +, or required, operator requires that the term after the + operator to exist
somewhere in a field of a single document or form.

Example: To search for documents containing "jakarta” with or without "CA Clarity
PPM", use the query:
+"jakarta CA Clarity PPM"
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NOT

The NOT operator excludes documents or forms that contain the term after the
NOT operator. You can use the symbol ! in place of the NOT operator.

Example: To search for documents that contain "jakarta apache" but not "jakarta
CA Clarity PPM", use the query:
"jakarta apache" NOT "jakarta CA Clarity PPM"

or,
"jakarta apache" ! "jakarta CA Clarity PPM"

The NOT operator cannot be used with a single term. This query returns no results:
NOT "jakarta apache"

- (prohibit)

The -, or prohibit, operator excludes documents that contain the term after the -
operator.

Example: To search for documents and forms that contain "jakarta apache" but not
"jakarta CA Clarity PPM", use the query:
"jakarta apache" - "jakarta CA Clarity PPM"

Form Subqueries in a Global Search

Subqueries allow you to control the Boolean logic during global searches by grouping
clauses with parentheses. For example, to search for documents and forms that contain
either "jakarta" or "apache" and "website", include the following sub query in the query:

("jakarta" OR "apache") AND "website"

The preceding query helps ensure that "website" exists and that either term, "jakarta"
or "apache", possibly exist.

Escape Special Characters in Global Searches

Escape special characters in global searches properly. To escape these characters, use
the "\" (backslash) character before the special character. For example, to escape the
special characters in a global search for (1+1):2, use the following query:

\(IN+INV)\:2

The following table lists the special characters:

Special Character Description Rule
+ plus sign \+
- minus sign \-
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Special Character Description Rule

&& double ampersand \&&

| double solid vertical bars \l]

! exclamation point \!

( left parenthesis \(

) right parenthesis \)

{ left curly brace \{

} right curly brace \}

[ left square bracket \[

] right square bracket \]

A circumflex \A

" quotes \"

~ tilde \~

* asterisk \*

? question mark \?
colon \:

\ backslash \\
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Chapter 13: Timesheets

This section contains the following topics:

How to Submit a Timesheet (see page 109)
Configure Your Timesheet (see page 114)

How to Submit a Timesheet

As an application user, you are responsible for tracking the number of hours that you
work on specific tasks. Tracking work time using timesheets allows companies to plan
budgets for complex projects, track the allocation of resources, implement charge
codes, and so on. Therefore, your manager may ask you to track the hours you spend on
specific tasks for specific projects. Depending on the policy of your company, your
manager may also want you to track the hours you spend on tasks under various charge
codes and input methods. As an application user, you track your working hours, using
timesheets.

For more information about how projects are managed using CA Clarity PPM, see the
Project Management User Guide.
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The following diagram describes how an application user submits a timesheet.

Application
User

How to Submit a Timesheet

Access an Unsubmitted
Timesheet

v

Populate a Timesheet

v

Add Entries to a Timesheet
Manually

v

[Optional] Specify and Split
Entry Input Type and

(Optional) Add Indirect
Row Timesheet Entries to a

Charge Codes Timesheet
L 4
Enter Work Hours on a
Timesheet

v

Submit a Timesheet for
Approval

b SE—

Correct a Returned
Timesheet

Did your

Yes anager Approve No f
the
imesheet? Your Manager
Timesheet Returns your
Approved Timesheet

To submit a timesheet, perform these steps:

1. Access an Unsubmitted Timesheet (see page 111)

Populate a Timesheet (see page 111)

2
3. Add Entries to a Timesheet Manually (see page 112)
4

(Optional) Specify and Split Entry Input Type and Charge Codes (see page 112)
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5. (Optional) Add Indirect Row Timesheet Entries to a Timesheet (see page 113)
6. Enter Work Hours on a Timesheet (see page 113)
7. Submit a Timesheet for Approval (see page 113)

8. Correct a Returned Timesheet (see page 114)

Access an Unsubmitted Timesheet

After your manager registers you as a user, you can start to work with CA Clarity PPM.
To start tracking time with timesheets, access your unsubmitted timesheets.

Follow these steps:

1. Open Home, and from Personal, click Timesheets.

The timesheets list page appears with the unsubmitted timesheets up to the
current reporting period.

2. Click the Timesheet icon next to the timesheet.

The timesheet page appears.

Populate a Timesheet

When you first open a timesheet, the timesheet is blank, containing no tasks. To
prepopulate your current timesheet with tasks, click the Populate button on the
timesheet page.

Note: Depending on how your CA Clarity PPM administrator sets up your timesheet
options, prepopulating a timesheet does one of the following tasks:
m  Copies all of your assignments to the timesheet.

m  Copies the timesheet entries and actuals from the most recently submitted
timesheet to your current timesheet.
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Add Entries to a Timesheet Manually

After you populate your timesheet with tasks, you can add additional tasks from your
project. To manually add additional tasks to a timesheet, use the add task feature.
Follow these steps:
1. Click the Add Task button on the open timesheet.

A page opens with a list of tasks available to the user.

2. Select the check box next to the tasks you want to add to the timesheet, and then
click the Add button at the bottom of the page.

Your timesheet opens with the manually added tasks.

Specify Entry Input Type and Charge Codes

Input type and charge codes are used for payroll purposes. If your company uses these
codes, your project manager can make them available to you in your timesheets. Your
manager may also want you to split entries in this process. Verify the policy of your
company on input type and charge codes before submitting your timesheets.

For more information about this topic, see the Project Management User Guide.

Follow these steps:
1. Open the timesheet.

2. Select an input type code or charge code from the Input Type Code or Charge Code
drop-down for the desired time entry row.

3. (Optional) Select the check box next to the timesheet entry you want to split it, and
click Split.

Note: This step is appropriate when your manager wants you to enter specific hours
under two different charge codes. After you split the entry, you can select a type
code or charge code from the Input Type Code or Charge Code field for the second
entry.

4. Save the changes.
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Add Indirect Row Timesheet Entries to a Timesheet

Your manager may want you to add indirect rows to a timesheet under an indirect
category. To fulfill the specific requirements of your company, add an indirect row
timesheet entry to a timesheet.
Follow these steps:
1. With your timesheet open, click New Indirect Row.

A new entry is created.
2. If your company uses Charge Codes or Input Type Codes, select them.

3. Save the changes.

Enter Work Hours in a Timesheet

To record the time you worked each day on specific task assignments, use the timesheet
page of your current work period.

Note: You can also distribute the number of hours for a single task evenly across all
working days, by entering the total number of hours you worked in the Total column for
the time entry row. If you enter values in both the Date and Total cells, the Date cell
value overrides the Total cell value.

To track the time you spend on tasks each week, enter work hours on a timesheet.

Follow these steps:
1. Open the timesheet.
The timesheet page appears.

2. Enter the number of hours you worked on each assignment each day in the Date
cells of the timesheet.

3. Save the changes.

Submit a Timesheet for Approval

When you submit a timesheet, it goes to your manager for approval. The status of the
timesheet is Unapproved until your manager approves it. To send a timesheet to your
manager for approval, submit the timesheet.

Do one of the following:

m  From the timesheets list page, select the timesheet, and click Submit for
Approval.

m  Open the timesheet, and click Submit for Approval.
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Correct a Returned Timesheet

When your manager returns a timesheet, you receive a notification. The method of this
notification depends on your account settings. If your manager returns a timesheet to
you to correct, use the following process to correct the timesheet.

Follow these steps:

1. Access your timesheet.

Note: The returned timesheet may have notes from your manager about what to
correct. The Paper and Pencil icons on the timesheet indicate if there are new
notes. For more information about timesheet notes, see the Basics User Guide.

2. Make the corrections to your timesheet as needed.
3. Submit your timesheet for approval.

Your manager is notified that the corrected timesheet is ready for review and
approval.

Configure Your Timesheet

You can configure your timesheet to display only the columns that you want to see.
Select the sorting method for the timesheet and set other timesheet options.
Follow these steps:

1. Open the timesheet to configure.

2. Click the Configure link.

3. Inthe Content and Layout section, select a column labels to display on the
timesheet from the Available Columns list. Then, move them to the Selected
Columns list.

4. Specify the following sorting options:
Default Sorting Column
Specifies the column to sort the tasks on the Timesheet page.
Values:
m Investment. The name of the project that includes the task.

m  Description. The task description.
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6.

Sorting Order
Specifies the order of sorting the column.
Values:
m  Ascending. Sorts the column from lowest value to highest.
m  Descending. Sorts the column from highest value to lowest.
In the Time Entry Options section, complete the following fields:
Auto-Populate
Automatically populates all subsequent timesheets according to the rule set.
Values:
m  Off. Do not auto-populate timesheets.

m  Copy time entries from the previous timesheet. Populates new timesheets
with the task entries from the current timesheet.

m  Copy time entries from the previous timesheet and include actuals (actuals
not copied for incidents). Populates new timesheets with the task entries
and daily actuals from the current timesheet. Actuals for one-time time
entries, such as vacation or sick time, are not copied.

Display Unit
Indicates the measure of time entries by hours or days.
Decimal Place

Indicates the number of decimal places for the time entry display unit selected.

Save your changes.
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Chapter 14: How to Run or Schedule a
Report to Run

Reports are documents that organize and display extracted CA Clarity PPM information.
Use the reports to capture and analyze information that is related to your work. You can
run and view out-of-the-box reports or reports that are designed for your specific needs.

This section contains the following topics:

Security for Reports (see page 117)

Run or Schedule a Report to Run (see page 118)

Edit Scheduled Report Run Properties (see page 119)
Delete a Scheduled Report Run (see page 120)

View a Generated Report (see page 121)

Delete Generated Reports (see page 122)

Jobs Affecting Report Information (see page 122)

Security for Reports

Security for reports has three levels. The following table describes what occurs at each
level of access. The CA Clarity PPM administrator grants you the access rights to specific
features.

Access Level Description

Report access Allows you to view reports. When you have access at
this level, you can open the Available Reports page.
The Reports - Access right includes this level of
access.

You can be granted instance access rights to view and
run a specific report. The Report - Run access right
lets you run a report and view the output. This access
right does not let you change the parameters that
filter information for a report.

Report definition Allows you to you edit a specific report definition.
When you have this level of access, you can change
the report parameters to filter information for a
report. The Reports and Jobs - Edit Definition instance
access right lets you edit a specific report definition.
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Run or Schedule a Report to Run

Row-level security within a This access level helps ensure that information is

report provided to you if you have the right to view the
information. The row content that appears in each
report varies depending on the access rights you
have to items contained in the report. For example, if
you run a report that lists information for multiple
projects, only those projects to which you have rights
appear in the report.

Run or Schedule a Report to Run

The Available Reports page lists all reports that a user or administrator can access and
can run immediately or can schedule to run later. The report type is the user view of the
report definition. Each available report has a corresponding definition and one report
type. From this view, you can select a report type and can set the run criteria. You
cannot delete or remove available reports.

The scheduled report runs let you set up recurring schedules for your frequently viewed
reports. By scheduling the reports to run in advance, the updated reports are available
when you need them.

Note: If you have personalized the Overview page to display the My Reports portlet, you
can add and run any available report from this portlet.

Follow these steps:

1. Open Home, and from Personal, click Reports and Jobs.

2. Specify the filter criteria, or click Show All to view a list of all available reports.

3. Click the name of the report you want to run or schedule.

4. Complete the requested information. The following sections require explanation:
General

Edit the report name. For scheduled runs, you can change the name to
distinguish each instance of a run. For example, Retailing Banking - Monthly
Rate Extraction run.

For submitted scheduled report entries, a read-only job ID and status are
displayed.

Parameters

Set the parameters as desired. This section appears only if your CA Clarity PPM
administrator defined the parameters. Click Save Parameters to save the
defined set of parameters for reuse. The saved parameters display in the list on
the Available Jobs list page below the report type from which it is based.
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Edit Scheduled Report Run Properties

5.

When

Defines the interval on which the report runs.

Select Scheduled to run the report later. To run the report at a recurring time,
click the Set Recurrence link.

You can also set the recurrence of a scheduled report by using the UNIX
Crontab. To use crontab, select Use UNIX Crontab Entry Format and enter the
schedule. For example:

001,15 **
means run the report at midnight on the 1st and 15th of every month.

You can use the crontab option on Windows, Linux, and Unix operating systems
where the CA Clarity PPM instance is running. When you use this option, the
scheduled configuration takes the server system time where the CA Clarity
PPM instance is running.

Note: For more information about the UNIX Crontab format and special
character usage, see the Oracle Documentation.

Submit your changes.

Edit Scheduled Report Run Properties

Report run properties include scheduling and notification information, and any
parameters that you can customize. The Scheduled Reports page lists the report
scheduled run times and report run statuses a user or administrator has created. A
single report can have many scheduled runs. All scheduled report runs (except the
deleted reports) appear in the list regardless of their status.

You can edit the properties of scheduled report runs that have the Canceled or
Completed status using the Report Properties page. Otherwise, you can only view report
run properties.

A scheduled report run can have one of the following statuses:

Canceled. The scheduled run is stopped and future recurring runs permanently
canceled.

Completed. The single, nonrecurring scheduled run is complete and the generated
report output is available.

Note: Recurring scheduled runs never show a Completed status.

Chapter 14: How to Run or Schedule a Report to Run 119


http://docs.oracle.com/
http://docs.oracle.com/

Delete a Scheduled Report Run

m  Paused. The scheduled run is stopped temporarily.
®m  Running. The scheduled run is in progress.

m  Scheduled. The scheduled run starts generating the report on its prescribed date
and time.

m  Waiting. The scheduled run cannot start generating the report until an incompatible

report or job run is completed.

Note: If you schedule a report to run only once, you can only edit its properties before
the scheduled run time.

Follow these steps:

1. Open Home, and from Personal, click Reports and Jobs.

2. Open the Reports menu, and click Scheduled Reports to edit the schedule of an
existing report run.

3. Click the name of the report you want to edit.

4. Edit the information and save your changes.

Note: If a report fails, check the status of scheduled runs for additional information
or contact your administrator for any assistance.

Delete a Scheduled Report Run

You can manage a scheduled report run in the following ways:
®  Pause or resume a scheduled report run

Pausing scheduled report runs temporarily stops the report from running. When in
this state, the report cannot run at its scheduled time until you resume the report
run. When you resume the report runs, it runs at its next scheduled run time. You
can pause reports that have a Scheduled status.

m  Cancel a scheduled report run

Canceling scheduled runs stops the run immediately and cancels any future runs. A
cancelled run remains listed on the scheduled reports page with a status Cancelled
status. Once you cancel a run, you cannot change its status or cannot edit any of its
properties.

m  Delete a scheduled report run

You can delete scheduled runs with a Cancelled or Completed status. Deleting a
scheduled run does not delete the report type, or any completed generated reports
that are listed in the Reports Library.
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View a Generated Report

The following procedure explains how to manage a scheduled report run.

Follow these steps:
1. Open Home, and from Personal, click Reports and Jobs.
2. Open the Reports menu, and click Scheduled Reports.

3. Select the check box next to the scheduled report and complete one of the
following actions:

m Click Pause.
m Click Resume.
m Click Cancel Job.

m Click Delete Job.

View a Generated Report

The Report Library page lists all the generated reports a user has access to view. The
report instance is the output that is generated from a scheduled run. Reports run
immediately and can be viewed immediately after they are generated. You can also save
and share reports with others.

If the scheduled report run recurs, then an instance of the report log is generated for
each recurrence. For example, if a scheduled report run is set to recur monthly, then an
instance of that report is created each month.

You must have Adobe Acrobat Reader installed to view reports.

Note: For any reports that run immediately, you can view the report immediately. You
can also save the report and view it later from the Report Library page.
Follow these steps:
1. Open Home, and from Personal, click Reports and Jobs.
2. Open the Reports menu, and click Report Library.
3. Complete any one of the following steps:
m  Click the Open Report icon next to the report to review.

m  Click the Report link to view run properties.
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Delete Generated Reports

Delete Generated Reports

You can delete generated reports as needed. You can also schedule the Remove Job

Logs and Report Library entries job run to remove outdated reports from the Reports
Library periodically.

For more information, see the Administration Guide.

Follow these steps:
1. Open Home, and from Personal, click Reports and Jobs.
2. Open the Reports menu, and click Report Library.

3. Select the check box next to the report, and click Delete.

Jobs Affecting Report Information

The Setup and Update Data Used by Reports and the Time Slicing jobs generate the
report information. If these jobs fail, reports can be affected. If the report information
does not display, it implies that one of the jobs have failed to run.

Contact your CA Clarity PPM administrator or see the Administration Guide for more
information.
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Chapter 15: How to Run or Schedule a Job
to Run

Jobs are sets of actions used by the application to perform automated administrative
processes regularly. For example, populating or refreshing database tables and running
background processes. A job can be composed of queries, statements, or procedures.

Use the Scheduled Job page to view the run times of a job and the run status. All
scheduled runs (except deleted ones) are listed regardless of their status.

This section contains the following topics:

Statuses for Scheduled Job Runs (see page 123)
Run or Schedule Jobs to Run (see page 124)

Edit Scheduled Job Run Properties (see page 125)
Manage a Scheduled Job Run (see page 126)
View or Delete the Job Log (see page 127)

Statuses for Scheduled Job Runs

A scheduled run can have one of the following statuses:

Cancelled

Indicates that the scheduled run was stopped and future recurring runs
permanently cancelled.

Completed

Indicates that the single, nonrecurring scheduled run has completed. If the job
definition is set to generate a log, you can view it in the Job Log.

Note: Recurring scheduled runs never show a status of Completed.
Paused

Indicates that the scheduled run is stopped temporarily.
Running

Indicates that the scheduled run is in progress.
Scheduled

Indicates that the scheduled run starts executing the job on its prescribed date and
time.
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Run or Schedule Jobs to Run

Waiting

Indicates that the scheduled run has reached its scheduled run date and time, but
cannot start executing the job until an incompatible report or job completes
running.

Pending for Process Engine

Indicates that the status appears only if the process engine is not run before the
Assign Incident job is run.

Run or Schedule Jobs to Run

The Available Jobs page list all jobs that a user or administrator can access and can run
immediately or can schedule it to run later. The report type is the user view of the
report or job definition. Each available job has one corresponding definition and one job

type.

Follow these steps:

1. Open Home, and from Personal, click Reports and Jobs.

2. Open the Jobs menu, and click Available Jobs.

3. Click the name of the job you want to run or schedule.

4. Complete the requested information. The following sections require explanation:
General

Edit the job name. For scheduled runs, you can change the name to distinguish
each instance of a run. For submitted scheduled job entries, a read-only job ID
and status are displayed.

Parameters

Set the parameters as desired. This section appears only if your CA Clarity PPM
administrator defined the parameters. Click Save Parameters to save the
defined set of parameters for reuse. The saved parameters display in the list on
the Available Jobs list page below the job type from which it is based.
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Edit Scheduled Job Run Properties

5.

When

Defines the interval at which the job runs. Select Scheduled to run the job later.
To run the job at a recurring time, click the Set Recurrence link.

You can also set the recurrence of a scheduled job using the UNIX crontab. To
use crontab, select Use UNIX Crontab Entry Format and enter the schedule. For
example:

001,15 **
means run the job at midnight on the 1st and 15th of every month.

You can use the crontab option on Windows, Linux, and Unix operating systems
where the CA Clarity PPM instance is running. When you use this option, the
scheduled configuration takes the server system time where the CA Clarity
PPM instance is running.

Note: For more information about the UNIX Crontab format and special
character usage, see the Oracle Documentation.

Submit your changes.

Edit Scheduled Job Run Properties

The Scheduled Jobs page lists the run times of a job and the run status. All scheduled
runs (except deleted ones) are listed regardless of their status. Using the Job Properties
page, you can edit the properties of scheduled job runs that have statuses as Canceled
or Completed. Otherwise, you can only view job run properties.

A scheduled job run can have one of the following statuses:

Canceled. The scheduled run is stopped and future recurring runs permanently
canceled.

Completed. The single, nonrecurring scheduled run is complete and the generated
report output is available.

Note: Recurring scheduled runs never show a Completed status.
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Manage a Scheduled Job Run

Paused. The scheduled run is stopped temporarily.
Running. The scheduled run is in progress.

Scheduled. The scheduled run starts generating the report on its prescribed date
and time.

Waiting. The scheduled run cannot start generating the report until an incompatible
report or job run is completed.

Pending for Process Engine. This status appears only if the process engine is not run
before the Assign Incident job is run.

Note: If you schedule a job to run only once, you can only edit its properties before the
scheduled run time.

Follow these steps:

1.
2.

Open Home, and from Personal, click Reports and Jobs.

Click the Jobs menu, and click Scheduled Jobs to edit the schedule of an existing job
run.

Click the name of the job you want to edit.

Edit the information and save your changes.

Note: If a job fails, check the status of scheduled runs for additional information or
contact your administrator for any assistance.

Manage a Scheduled Job Run

You can manage a scheduled job run in the following ways:

Pause or resume a scheduled report run

On the Scheduled Jobs page, you can pause any job with a status of Scheduled and
can resume the job. You can pause a job run to stop temporarily from running.
When in this state, the job cannot run at its scheduled time until you resume it.
When you resume the job, is runs at its next schedule run time.

Cancel a scheduled report run

You can cancel a schedule job run to stop the job immediately and cancel any future
runs, but continues running in the background. A canceled job remains in the
scheduled jobs list with a Canceled status. The status takes some time to reflect in
the Scheduled Jobs list page. After you cancel a job run, you cannot change its
status or cannot edit any of its properties.

Delete a scheduled report run

You can delete the scheduled job runs with a Canceled or Completed status using
the Scheduled Jobs page. Deleting scheduled runs does not delete the job type, or
any of the run job logs.
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View or Delete the Job Log

The following procedure explains how to manage a scheduled job run.

Follow these steps:
1. Open Home, and from Personal, click Reports and Jobs.
2. Open the Jobs menu, and click Scheduled Jobs.

3. Select the check box next to the scheduled job and complete one of the following
actions:

m Click Pause.
m Click Resume.
m Click Cancel Job.

m Click Delete Job.

View or Delete the Job Log

You can use the Log page to view information about a job run or delete outdated job
logs. A job log consists of a read-only version of its run properties and lists job entries,
times, and any messages. If a job fails, the log indicates the nature of the error.

You can schedule the Remove Job Logs and Report Library entries job to remove job logs
and report instances periodically from the Report Library or Job Log.

Follow these steps:

1. Open Home, and from Personal, click Reports and Jobs.

2. Open the Jobs menu, and click Log.
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Appendix A: Keyboard Shortcuts

This section contains the following topics:

CA Clarity Keyboard Shortcuts (Basic Features) (see page 129)
CA Clarity Keyboard Shortcuts (Actions) (see page 129)

CA Clarity Keyboard Shortcuts (Lists) (see page 130)

Keyboard Shortcuts for Time-Scaled Value Cells (see page 131)

CA Clarity Keyboard Shortcuts (Basic Features)

The following table shows the keyboard shortcuts for basic features available on all CA
Clarity PPM pages.

Feature Key Combination
Home Menu Ctrl+Alt+h
Administration Menu Ctrl+Alt+a
Favorites Menu Ctrl+Alt+f
Back Ctrl+Alt+b

or

Alt+Left Arrow
Home Page Ctrl+Alt+Home
Refresh Ctrl+Alt+F5
Search Ctrl+Alt+s
History Ctrl+Alt+v
Help F1

CA Clarity Keyboard Shortcuts (Actions)

The following table shows keyboard shortcuts for actions on CA Clarity PPM pages.

Action Key Combination  Alternate Accessibility
Key Combination

Activate a field editor (for example, a Enter Alt+Enter
date picker)
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CA Clarity Keyboard Shortcuts (Lists)

Action

Key Combination

Alternate Accessibility

Key Combination

Close a popup Esc Shift+Esc

Open a tab menu Enter Alt+Enter

Move left, right, up, or down ina menu  Left Arrow Alt+Up Arrow
Right Arrow Alt+Down Arrow
Up Arrow Alt+Up Arrow
Down Arrow Alt+Down Arrow

Select a highlighted menu item Enter Alt+Enter

Open a link in a list page Ctrl+Enter

Select or clear a check box Space Bar

Note: Focus must be on the checkbox.

Expand a hierarchical list Space Bar

Note: Focus must be on the + in the
hierarchical list.

CA Clarity Keyboard Shortcuts (Lists)

The following table shows the keyboard shortcuts for lists.

Action Mode Keyboard Combination
Switch between edit and display Display, Edit Enter
mode in a list
Move from cell to cell through a list Display Left Arrow
(grid) Right Arrow
Up Arrow

Down Arrow

Move to different areas within a Display Tab (Forward)

list: portlet icons, column headers, Shift+Tab (Back)

body of list, buttons

Switch to display mode Edit Esc or Enter

Move left or right within a cell Edit Left Arrow
Right Arrow

Move from editable cell to editable Edit Tab (Forward)
cell Shift+Tab (Back)
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Keyboard Shortcuts for Time-Scaled Value Cells

Action Mode Keyboard Combination

Move to the end of a row Edit Ctrl+Right Arrow

Note: If the action is on a TSV row,
repeat the keyboard combination
to leave the TSV section.

Move to the beginning of a row Edit Ctrl+Left Arrow

Page up or down Display, Edit Ctrl+Alt+Up Arrow
Ctrl+Alt+Down Arrow

Move to the top or bottom of a list Display, Edit Ctrl+Up Arrow

Note: If the action isin a TSV cell, Ctrl+Down Arrow

repeat the keyboard combination
to leave the TSV section.

Open a drop-down list or a date Edit Enter
selector

Move through selection itemsina  Edit Up Arrow
drop-down Down Arrow
Select a highlighted value in a Edit Enter
drop-down or a date selector

Highlight a date in a date selector  Edit Down Arrow
Add a new linein along text area  Edit Ctrl+Enter

Keyboard Shortcuts for Time-Scaled Value Cells

The following table shows the keyboard shortcuts for time-scaled value cells in a list.

Action Key Combination Alternate
Accessibility Key
Combination

Select a TSV row Shift+Ctrl+Right Arrow

Select a TSV column Shift+Ctrl+Down Arrow

Select a single cell to the left or ~ Shift+Right Arrow

right of the current cell Shift+Left Arrow
Select a single row above or Shift+Up Arrow
below the current cell Shift+Down Arrow
Copy a TSV cell Ctrl+c

Paste a TSV cell Ctrl+v

Cut a TSV cell Ctrl+x
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Keyboard Shortcuts for Time-Scaled Value Cells

Action

Key Combination

Alternate
Accessibility Key
Combination

Undo a cut, copy, or paste
operation

Ctrl+z

Copy from Excel to a TSV cell

Ctrl+c and Ctrl+v
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